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What's in the box 

 TomTom Rider navigation device 

 

 

 Charging bike mount and battery cable 

 

 USB home charger 

 

 RAM mounting kit 

What's in the box 
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 Tyre route software for your computer - installation file is supplied on your device 

 Documentation pack 

Extra items supplied in Premium pack: 

 Car mounting kit 

 

 

 Anti-theft solution 

 

 

 Travel carry case 

 

For more information, go to tomtom.com/accessories. 

http://www.tomtom.com/accessories
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Mounting your navigation device 

Attach the RAM™ mount kit to your motorcycle as shown on the Installation Poster, then place 

your TomTom Rider in the holder. When you are attaching the mount kit to your motorcycle, fol-

low these guidelines: 

 If you are unsure about attaching the mount kit yourself, ask a professional to fit it for you. 

 If you choose to attach the mount kit yourself, note that the Active Dock has a built-in fuse. 

This means that you don’t need to add a fuse yourself while performing the connection be-

tween the device and the motorcycle battery. 

 Make sure that the mount kit does not interfere with any of the controls on the motorcycle. 

 Always use the correct tools. If you use unsuitable tools, you may damage or break the mount 

kit. 

 Do not overtighten nuts. You may crack parts of the mount kit or damage your handlebars if 

you overtighten the nuts. 

 If you are using the u-bolt, don’t forget to put the rubber caps provided over the exposed 

threads. 

 Damage due to modifications, improper installation, road hazards or accident are not covered.  

Neither RAM nor TomTom shall be liable for any injury, loss or damage, direct or consequen-

tial, arising from improper installation or inability to use product. Before use, the user shall 

determine the suitability of the product for its intended use. The user assumes all risk and lia-

bility, whatsoever, in connection with the mount. 

Connecting the dock cable 

 

1. The red POS(+) contact needs to be connected to the motorcycle's +12V battery supply. 

2. The black NEG(-) wire needs to be connected to the motorcycle's -(GND) battery supply. 

Read me first 
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3. The dock connector needs to be plugged into the TomTom Rider dock. 
 

Using a headset 

We recommend using a compatible headset with your TomTom Rider to hear spoken instructions, 

make and receive hands-free phone calls and hear warning sounds on your TomTom Rider. This 

makes riding with your TomTom Rider as safe as possible. For more information and a full list of 

compatible headsets, go to tomtom.com/riderheadsets. 

The instructions below describe how to set up a Bluetooth® headset. If you did not establish a 

Bluetooth connection between your Bluetooth headset and your TomTom Rider when you first 

turned your TomTom Rider on, you can establish the connection at any time by doing the follow-

ing: 

1. Turn the headset on or off by following the instructions for your particular brand of headset.  

2. From the Main Menu, tap options.  

3. Tap Connect to headset and follow the instructions to establish the connection. 

4. Attach your headset to your helmet.  

Make sure you position the microphone correctly. For best results, don’t position the micro-

phone directly in front of your mouth, position it just to the side of your mouth. 

An image of the parts of a typical headset is shown below: 

 

 

1. Microphone 

2. On/Off button 

3. Speakers 

4. LED 

5. Volume down 

6. Volume up 

7. Charging connector 

Before you can use your Bluetooth headset, fully charge the headset using the charger supplied 

with the headset. 
 

http://www.tomtom.com/riderheadsets
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Switching on 

Your TomTom Rider switches on when you switch your motorcycle ignition on. Your TomTom 

Rider switches off when you switch your ignition off. 

The first time you switch on your TomTom Rider, it may take up to 20 seconds to start.  

Before you use your TomTom Rider for the first time, it’s a good idea to charge it fully. 

The battery in your TomTom Rider navigation device charges when you connect it to the home 

charger or to your computer. 

Note: You should plug the USB connector directly into a USB port on your computer and not 

into a USB hub or USB port on a keyboard or monitor. 

 

Tip: To switch your TomTom Rider on when your motorcycle engine is not running, press and 

hold the On/Off button for 2 seconds or until your TomTom Rider starts.  To switch off your 

TomTom Rider, press and hold the On/Off button for 2 seconds. 

 
 

Setting up 

Important: Take care to select the correct language as the language you choose will be used for 

all text on the screen. 

When you first switch on your device, you have to answer a few questions to set up the device. 

Answer the questions by tapping the screen. 
 

GPS reception 

Your TomTom Rider must be outside to be able to locate your current position. Make sure that 

you are in an open place without tall buildings or trees around you. 

The first time you start your TomTom Rider, it can take a few minutes for the device to find your 

current position. In the future, your position will be found much faster, normally within a few sec-

onds. 

Your TomTom Rider does not transmit your location, so others cannot use it to track you while 

you are driving. 

TomTom Rider uses a GPS receiver to locate your current position. 
 

Using the anti-theft solution 

If your box includes an anti-theft solution, it is supplied in two parts: 

 A RAM lock for the mount. 

This lock prevents the unscrewing of the RAM arm from the bike. 

 A lock for the TomTom Rider itself. 

This lock prevents the disconnection of the TomTom Rider from the dock. 
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Important: Both locks have keys so you need to make sure that you keep these two extra keys 

with you at all times! 

TomTom Rider shown without locks 

 

TomTom Rider shown with both locks 
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Safety messages 

Please read and take note of the following important safety messages: 

 Check your tire pressure regularly. 

 Service your vehicle regularly. 

 Medication can affect your riding or driving ability. 

 Always use seat belts if available. 

 Before setting off on a motorcycle, fasten your helmet correctly. 

 If riding a bike, always wear protective clothing and equipment. 

 When riding a motorcycle, be extra vigilant and always ride defensively. 

 Don’t drink and drive. 

 Most accidents happen less than 5 km from home. 

 Obey the rules of the road. 

 Always use your turn signals. 

 Every 2 hours, take a break for at least 10 minutes. 

 Keep your seat belts on. 

 Keep a safe distance from the vehicle in front. 

Safety 
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About the Driving View 

When your TomTom Rider navigation device starts for the first time, you are shown the Driving 

View along with detailed information about your current position. 

Tap the center of the screen at any time to open the Main Menu. 
 

The Driving View 

 

 

1. Zoom button - tap this button to zoom in and out. 

When tapped, large + and - buttons appear for easy use when wearing gloves. 

2. Quick menu. 

 

 

 

Tip: When you see this symbol in the guide, it means that this is 

an option that can be added to your Quick Menu for easy ac-

cess. For more information, see About the Quick Menu in this 

guide.  

3. Your current position. 

The Driving View 
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4. The name of the next major road or road sign information, if applicable. 

5. Battery level indicator. 

6. Your speed and the speed limit, if known.  

Tap this area to repeat the last spoken instruction and to change the volume. When tapped, 

large + and - buttons appear for easy use when wearing gloves. 

7. Navigation instruction for the road ahead. 

Tap this panel on the status bar to switch between 2D and 3D views of the Driving View. 

Quick Menu option! 

8. The name of the street you are on. 

9. The remaining trip time, the remaining distance and your estimated arrival time.  

Tap this part of the status bar to open the Route Summary screen. 
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About the Main Menu 

The Main Menu is the starting point for planning a route, looking at a map or changing your device 

settings. 

To open the Main Menu from the Driving View, tap the center of the screen. 

 

To return to the Driving View from the Main Menu, tap done. 
 

Main Menu buttons 

The following buttons are shown on the Main Menu: 

 

Plan route 
 

Tap this button to plan a new route. This button is shown when you have 

not planned a route. 

 

Change route 
 

Tap this button to change the current route. 

This button is only shown while there is a planned route on your device. 

 

Plan winding route 
 

Tap this button to plan a route that avoids unnecessary highways and 

includes winding roads. 

 

Manage itineraries 
 

Tap this button to plan a trip that includes waypoints and your final des-

tination. You can also access the route files saved on your device. 

Main Menu 
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sound 
 Quick Menu option! 

Tap this button to turn the sound off. 

 

sound 
 

Tap this button to turn the sound off. 

 

options 
 

Tap this button to adjust the settings for your device. For more infor-

mation, see About Options in this guide. 

 

view map 
 

Tap this button to look at the map. 
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About the Quick Menu 

The Quick Menu offers a fast and safe way to use your TomTom Rider. 

When you use the Quick Menu, the number of taps you need to make is reduced and this makes 

the device easier to use with gloves. 

There are several Quick Menu items to choose from. You can choose just one or several depend-

ing on the features you use the most. 

 

 

 

Tip: When you see this symbol in the guide, it means that this is an 

option that can be added to your Quick Menu for easy access. 

 

 
 

Setting up the Quick Menu 

To set up the Quick Menu, do the following: 

1. Tap the screen to bring up the Main Menu. 

2. Tap options in the Main Menu. 

3. Tap Quick menu preferences. 

4. Select one or more checkboxes next to the options you want to include in your Quick Menu. 

5. Tap Done. 

Your Quick Menu is now ready to use. To use the Quick Menu, go to the Driving View and tap this 

button: 

 
 

Using the Quick Menu 

Here are some examples of how you can use the Quick Menu: 

 Changing a route to include a gas station normally requires 5-6 taps but when you use the 

Quick menu, you only need to tap twice. 

 When you use the Call button in the Mobile phone menu, you can call any phone number, but 

it requires several taps. The Call button in the Quick Menu, however, is like a speed-dial button 

and allows you to call a pre-set number with very few taps. 

 If you want to skip a waypoint on your scenic route, you can do with this with two taps in the 

Quick Menu by using Go to previous waypoint or Go to next waypoint. It takes at least six taps 

using the Main Menu. 

Quick Menu 
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Planning a winding route 

1. Tap the screen to open the Main Menu. 

2. Tap Plan winding route. 

You can enter an address in various ways, but we will enter the full address. 

3. Tap Address.  

4. Tap Street and house number. 

5. Start to type the name of the town where your trip will begin and tap the name when it ap-

pears in the list. 

Tip: When you plan a route for the first time you are asked to select the country or state. 

Your choice is saved and used for all future routes. You can change this setting by tapping on 

the flag and selecting a new country or state. 

6. Enter the street name and the house number, then tap Done. 

Tip: Before you start to enter a street name, City center is shown at the top of the list. This is 

useful if you do not have an address and only need general directions. 

7. Tap Done. 

The route is planned and a summary of the route is shown. 

 

 

 

8. Tap Done.  

Your navigation device is ready to guide you to your destination. 

Tip: If you are not happy with the selected route, tap Change route in the Route Summary 

screen to quickly see an alternative route. 
 

Planning a route 



20 

 

 

 

Planning a route with a new starting point 

To plan a route in advance of traveling or to use a starting point that isn't your current location, do 

the following: 

1. Tap the screen to open the Main Menu. 

2. Tap Plan route. 

3. Tap Depart from. 

 

 

You can enter an address in various ways, but we will enter the full address. 

4. Tap Address.  

5. Tap Street and house number. 

 

 

6. Start to type the name of the town where your trip will begin and tap the name when it ap-

pears in the list. 

Tip: When you plan a route for the first time you are asked to select the country or state. 

Your choice is saved and used for all future routes. You can change this setting by tapping on 

the flag and selecting a new country or state. 
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7. Enter the street name and the house number, then tap Done. 

Tip: Before you start to enter a street name, City center is shown at the top of the list. This is 

useful if you do not have an address and only need general directions. 

8. Enter the destination address, then select Now when asked for the departure time and then 

tap Done. 

The route is planned and a summary of the route is shown. 

Tip: Quick Menu option! You can add route summary to the Quick Menu. 

 

 

 

9. Tap Done.  

Your navigation device is ready to guide you to your destination. 
 

Planning a route 

1. Tap the screen to open the Main Menu. 

2. Tap Plan route. 

You can enter an address in various ways, but we will enter the full address. 
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3. Tap Address.  

 

 

4. Tap Street and house number. 

 

 

 

5. Start to type the name of the town where your trip will begin and tap the name when it ap-

pears in the list. 

Tip: When you plan a route for the first time you are asked to select the country or state. 

Your choice is saved and used for all future routes. You can change this setting by tapping on 

the flag and selecting a new country or state. 

 

 

 

6. Enter the street name and the house number, then tap Done. 
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Tip: Before you start to enter a street name, City center is shown at the top of the list. This is 

useful if you do not have an address and only need general directions. 

7. Tap Done. 

The route is planned and a summary of the route is shown.  

Tip: Quick Menu option! You can add route summary to the Quick Menu. 

 

 

 

8. Tap Done.  

Your navigation device is ready to guide you to your destination. 
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About winding routes 

The winding routes feature is for planning a route that avoids unnecessary highways and includes 

winding roads, with the aim of making the route a fun and entertaining ride. When planning the 

route, your TomTom Rider tries to guide you out of the city as quickly as possible. 
 

Switching on winding routes 

1. Tap the screen to bring up the Main Menu. 

2. Tap options. 

3. Tap Winding routes preferences. 

Some locations in the world have a lot of winding roads, others have very few due to larger 

populations or lots of cities. If you think that the winding roads suggested in your area are too 

winding or not winding enough, you can change the relative amounts of different types of 

roads in your route. 

 

 

Move the slider to choose the extent to which minor or major roads are part of your route. 

Move the slider to the left to choose more winding roads. 
 

Planning a winding route 

1. Tap the screen to open the Main Menu. 

2. Tap Plan winding route. 

You can enter an address in various ways, but we will enter the full address. 

3. Tap Address.  

4. Tap Street and house number. 

5. Start to type the name of the town where your trip will begin and tap the name when it ap-

pears in the list. 

Winding routes 
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Tip: When you plan a route for the first time you are asked to select the country or state. 

Your choice is saved and used for all future routes. You can change this setting by tapping on 

the flag and selecting a new country or state. 

6. Enter the street name and the house number, then tap Done. 

Tip: Before you start to enter a street name, City center is shown at the top of the list. This is 

useful if you do not have an address and only need general directions. 

7. Tap Done. 

The route is planned and a summary of the route is shown. 

 

 

 

8. Tap Done.  

Your navigation device is ready to guide you to your destination. 

Tip: If you are not happy with the selected route, tap Change route in the Route Summary 

screen to quickly see an alternative route. 
 

Winding roads and itineraries 

You can also use the winding routes feature in combination with the itinerary planner. 

Tip: The range of winding routes offered to you depends on the availability of alternative streets 

and on the distance between the waypoints. Waypoints force your route along a specific road. 

The number of alternative winding routes is reduced if you choose a lot of waypoints or if way-

points are a short distance from each other. As a result, we recommend using the minimum 

number of waypoints in an itinerary if you want to use the winding route option.  

There are two methods for using winding routes with itineraries. The first is to select just city cen-

ters and a route is planned bypassing those cities but using them as a guide. For example: 

1. City center 1 

2. City center 2 

3. City center 3 

4. Home location 

This method, as shown in the example above, calculates a route from your current position using 

the three city centers as a guide and finishes at your Home location. 

The second method uses actual locations that you know you want to visit. 
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For more information, see Creating an itinerary with a winding route. 
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About lane guidance 

Note: Lane guidance is not available for all junctions or in all countries. 

Your TomTom Rider navigation device helps you prepare for highway exits and junctions by 

showing the correct driving lane for your planned route. 

As you approach an exit or junction, the lane you need is shown on the screen. 
 

Using lane guidance 

There are two types of lane guidance: 

 Lane images 

 

Lane images are permanently switched on. 

Tip: Tap anywhere on the screen to return to the Driving View. 

 Instructions in the status bar 

 

 

Lane guidance in the status bar can be switched on and off. 

Advanced Lane Guidance 
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To switch off lane guidance in the status bar, tap options in the Main Menu, then tap Status 

bar settings. Clear the checkbox for Show lane guidance. 

Tip: If no lane guidance is shown in the status bar and all lanes are highlighted, you can use 

any lane. 
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About Itineraries 

An Itinerary is a plan for a trip that includes more locations than just your final destination. 

You could use an Itinerary for trips such as: 

 A riding holiday through a country with lots of stops. 

 A two day bike ride with an overnight stop. 

 A short ride which passes by Points of Interest. 

 A scenic route from a friend that you downloaded using HOME or the internet. 

In all these examples you could tap Navigate to... for each place. However, if you use an Itinerary, 

you can save time by planning everything in advance. 

An Itinerary can include the following items: 

 Destination - a location on your trip where you want to stop. 

 Waypoint - a location on your trip you want to travel through without stopping. 

 

 
 

Destinations are shown using this symbol. 

 
 

Waypoints are shown using this symbol. 

 
 

Creating an Itinerary 

1. Tap the screen to bring up the Main Menu. 

2. Tap Manage itineraries. 

3. Tap Create new. 

 

 

 

The Itinerary planning screen opens. At first there are no items in the Itinerary. 

4. Tap Add and select a location. 

Tip: You can add items to your Itinerary in any order and rearrange the order later. 
 

Itinerary planning 
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Start using an Itinerary 

When you use an Itinerary to navigate, the route will be calculated to the first destination on the 

Itinerary. Your TomTom Rider calculates the remaining distance and time to the first destination 

and not for the whole Itinerary. 

As soon as you start to use an Itinerary, the route is calculated from your current position.  

When you have passed a waypoint or reached a destination, it is marked as visited. 

Waypoints are shown on the map. Your device will not warn you when you are approaching a 

waypoint or when you arrive at a waypoint. 

1. Tap the screen to bring up the Main Menu. 

2. Tap Manage itineraries. 

3. Tap Start navigation. 

 

 

 

You are asked if you want to leave from your current position. 

 

 

 

 

Tip: You can add the following menu items to your Quick 

Menu: Continue Itinerary, Go to previous waypoint and Go to 

next waypoint.  

 
 

Organizing an Itinerary 

To edit an itinerary, tap Manage itineraries and then tap Edit current. 

Tap an item on your Itinerary to edit it. You then see a range of Itinerary editing features, as shown 

below: 

 

Mark as waypoint 
 

You can change a destination into a waypoint using this button. 

Remember that waypoints are points on your trip to your destination that 

you want to pass and destinations are places where you want to stop. 

This button is only shown if the item you tapped is a destination. 

 

Mark as destina-

tion 
 

You can change a waypoint into a destination using this button. 

Remember that destinations are places where you want to stop, and 

waypoints are points on your trip to your destination that you want to 

pass. 

This button is only shown if the item you tapped is a waypoint. 

 

Mark "visited" 
 

Tap this button to miss out part of your Itinerary. Your TomTom Rider 

will ignore this item and all the items before it in the Itinerary. 

It will navigate you to the next item in the Itinerary. 

This button is only shown if you are still due to visit this item. 
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Mark "to visit" 
 

Tap this button to repeat part of your Itinerary. Your device will navigate 

you to this item followed by the rest of the items in the Itinerary. 

This button is only shown if you have already visited this item. 

 

Move item up 
 

Tap this button to move the item up the Itinerary. 

This button is unavailable if the item is at the top of the Itinerary. 

 

Move item down 
 

Tap this button to move the item down the Itinerary. 

This button is unavailable if the item is at the bottom of the Itinerary. 

 

Show on map 
 

Tap this button to see the location of the item on the map. 

 

 

Delete item 
 

Tap this button to delete the item from the Itinerary. 

 

 
 

Sharing an Itinerary 

To share an itinerary with a friend using Bluetooth, do the following: 

Sending a file 

1. Tap the screen to bring up the Main Menu. 

2. Tap Manage itineraries. 

3. Tap Share. 

 

 

 

4. Tap Send to another device. 

5. Make sure that the other device is ready to receive the file and then tap Continue. 

6. Choose the device from the list. 

7. Tap the itinerary file that you want to share. 

The file is sent. 
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Receiving a file 

1. Tap the screen to bring up the Main Menu. 

2. Tap Manage itineraries. 

3. Tap Share. 

 

 

 

4. Tap Receive from another device. 

5. If the file is already waiting, tap Yes to receive it. 

Tip: Your device name is TomTom RIDER. 
 

Deleting an Itinerary 

1. Tap the screen to bring up the Main Menu. 

2. Tap Manage itineraries. 

3. Tap Delete. 

 

 

 

Your list of itineraries opens. 

4. Tap an itinerary to select it. 

5. Tap Yes to confirm that you want to delete the itinerary. 
 

Sorting or reversing an Itinerary 

To sort or reverse an Itinerary, tap Manage itineraries, followed by Edit current and then Options: 

 

Sort from my loca-

tion 
 

To sort the Itinerary into an order which starts from your current location, 

tap Sort from my location. 

This is useful if you are following a scenic route you downloaded using 

HOME or the internet. 

Use this option to drive directly to the closest point on the route and then 

follow the route from there, instead of starting at the official starting point 

of the Itinerary. 

 

Reverse route 
 

To reverse the order of locations in your current Itinerary, tap Reverse 

route. 
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Saving an Itinerary 

To save an itinerary with a new name or overwrite an existing stored itinerary, do the following: 

1. Tap the screen to bring up the Main Menu. 

2. Tap Manage itineraries. 

3. Tap Edit current. 

 

Your current itinerary opens. 

4. Make your changes. 

5. Tap Options. 

6. Tap Save route. 

7. Enter a new name for your itinerary or leave the name as it is if you wish to overwrite the ex-

isting stored version. 

8. Tap Done. 
 

Creating an itinerary with a winding route 

You can use the winding route feature in combination with the Itinerary planner. 

Tip: The range of winding routes offered to you depends on the availability of alternative streets 

and on the distance between the waypoints. Waypoints force your route along a specific road. 

The number of alternative winding routes is reduced if you choose a lot of waypoints or if way-

points are a short distance from each other. As a result, we recommend using the minimum 

number of waypoints in an itinerary if you want to use the winding route option.  

 

Note: Ensure that winding routes is switched on before you create your Itinerary. 

1. Tap the screen to bring up the Main Menu. 

2. Tap options. 

3. Tap Itinerary planning. 

4. Tap Add and select a location. 

5. If you choose city centers, your Itinerary looks like this: 
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A route is planned using the city centers as a guide for planning the winding road. You are not 

directed into the city centers as a part of your route. 

Note: To plan a circular route using city centers, the city centers should be at least 30km 

apart. 

6. If you choose specific locations in your Itinerary, your route takes you to your waypoints and 

destination using winding roads. 

7. Tap Done. When asked if you wish to navigate to the first destination now, select Winding 

routes as your route type. 
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Making changes to your route 

After you plan a route, you may want to change the route or even the destination. There are vari-

ous ways to change your route without the need to completely replan the entire trip. 

To change the current route, tap Change route in the Main menu: 

 

Change route 

 

 

Tap this button to change the current route. 

This button is only shown while there is a planned route on your device. 

 
 

Change route menu 

To change the current route or your destination, tap one of the following buttons: 

 

Avoid roadblock 
 

Quick Menu option! 

Tap this button while driving on a planned route, to avoid a roadblock or 

traffic congestion on the road ahead. 

Your device will suggest a new route which avoids the roads on your 

current route for the selected distance. 

If the roadblock or traffic congestion suddenly clears, tap Recalculate 

route to replan your original route. 

Important: Be aware that when a new route is calculated you might be 

asked to turn off the current road immediately. 

 

Calculate alterna-

tive 
 

Quick Menu option! 

Tap this button to find an alternative to the current route. 

This button is only shown while there is a planned route on your 

TomTom Rider device. 

This is a simple way to search for a different route to your current desti-

nation. 

Your device calculates a new route from your current location, to reach 

your destination using completely different roads. 

The new route is shown next to the original route so that you can select 

the route you want to use. 

Changing your route 
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Show another 
 

Tap this button to show another winding route. 

This button is only shown when there is a planned winding route on your 

TomTom Rider device. 

 

Travel via... 
 

Tap this button to change your route by selecting a location you want to 

travel past, perhaps to meet someone along the way. 

When you select a location to travel past, you are shown the same op-

tions and asked to enter the new address in the same way as when you 

plan a new route. 

Your device calculates the route to your destination via the selected loca-

tion. 

The selected location is shown on the map using a marker.  

You receive a warning when you reach your destination and when you 

travel past a marked location.  

 

Plan new route 
 

Tap this button to plan a new route. When you plan a new route, the old 

one is deleted. 

 

Cancel route 
 

Quick Menu option! 

Tap this button to delete the current route. 

 

Change waypoint 
 

Quick Menu option! 

Tap this button to go to the next or previous waypoint in your current 

Itinerary. 
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About recording your route 

There are several reasons why you may want to record a route. You may be on the riding vacation 

of a lifetime and want to share the route with fellow bikers or you may simply wish to build a col-

lection of your favorite routes. 

When the recording of a route stops, two files are created. The first file is a GPX file that holds very 

detailed information and can be viewed with software such as Google Earth. 

The second file is an ITN file that can be shared with other TomTom users and can be used to 

drive the route again using the Itinerary feature. 

You can also download GPX files from the internet and convert them to ITN files for sharing and 

riding using the Itinerary feature. 

Tip: You can also use Tyre to create, find and share routes. With one mouse click you can copy 

the routes that you make with Tyre to your TomTom Rider. See Installing Tyre. 
 

Starting route recording 

Important: You need at least 5MB of free space on your TomTom Rider before starting to record a 

route. 

Quick Menu option! 

To start recording your route, do the following: 

1. Tap the screen to bring up the Main Menu. 

2. Tap options. 

3. Tap Start recording. 

Tip: You can also select Record my GPS location in Quick menu preferences. You can then tap 

Start recording in the Quick Menu in the Driving View. 

As you ride, your TomTom Rider records your position every few seconds. During recording, you 

can continue to use your TomTom Rider as normal. You can safely turn your device off and on 

during recording. 

Recording your route 
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Installing Tyre 

Tyre, a tool for managing routes, has been included with your TomTom Rider. Tyre enables you to 

search, design and edit routes, send them to your device and share them with other riders. 

To install Tyre, do the following:  

1. Connect your TomTom Rider to your PC using the supplied USB cable. A drive called “RIDER” 

appears in Windows Explorer. 

2. In Windows Explorer, double click on the RIDER drive to open it. Look for a file called 

“TyreSetup.” 

3. Double-click the "TyreSetup" file to start the Tyre installer. Follow the instructions to install 

Tyre on your PC. 

4. Once installed, use Tyre to import, create or edit routes. Use the menu to send the route to 

your TomTom Rider or share it with other riders.  
 

Tyre FAQs 

I want to install Tyre using TomTom HOME, but I don’t know how to do this. 

See Installing Tyre. 

After starting up Tyre, I don’t see a map. What can I do? 

Most likely your computer is infected with malware that is preventing the map from being dis-

played. 

Use the malware scanner from Malwarebytes to clean your computer: 

www.malwarebytes.org/products/malwarebytes_free 

For your information: some people who were though their computers were free from malware, 

because they were already using a malware scanner, discovered that the scanner from Malware-

bytes detected additional malware, and removing that malware solved their problem! 

Tyre is very slow or seems to freeze. What is going on?  

This behavior occurs when MS Internet Explorer is not installed on your system or when it is not 

up to date. Furthermore, it may occur when your file contains a lot of waypoints or POIs. It is just 

Windows slowing down as memory fills up. 

Depending on the number of waypoints or POIs and the speed of your computer, Tyre may seem 

to hang. It is not really hanging, but it might take a lot of time for the activity to complete. 

We recommend you use a maximum of 100 waypoints or POIs for one file. If there are more, split 

the file, using "Split" or "Reduce" from the "File" menu. 

Is there a Tyre version for Mac computers?  

We have lots of plans to port Tyre to other platforms. But since we are just a small company, it will 

take some time to realize them. 

Uploading and sharing routes 

http://www.malwarebytes.org/products/malwarebytes_free
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For the time being, you might consider installing a Windows emulator (like WINE, a piece of free 

software) on your Mac. It will create a Windows environment on your computer. You can use that 

environment to run Tyre. 

On opening the map, I get an error message. 

There might be an error in your Internet Explorer settings. Follow these steps: 

 Open your Internet Explorer. 

 Select Tools > Internet Options > Advanced tab > Restore Advanced Settings. 

 Restart Tyre and your Internet Explorer. 
 

About GPX files 

Contents 

A very detailed recording of where you have been on your route, including any off-road locations. 

Location 

GPX folder on your TomTom Rider. 

Using the file 

There are several things you can do with your GPX file: 

 Use Tyre to view your route file. 

 Connect your TomTom Rider to your computer and view the file using software such as 

Google Earth. 

Note: While viewing your recording, you may notice that the recorded GPS locations do not 

always correspond with the roads. This can happen for several reasons. Firstly, your device 

tries to keep the files small and this can cause a slight loss of data precision. Secondly, your 

device records the actual data from the GPS chip for an accurate representation of where 

you’ve been, rather than what you see on your screen. Thirdly, the software with which you 

view the recording may have the maps misaligned. 

 Share the file with friends by sending it using email or the internet on your computer. 

Receiving a GPX file 

If you receive a GPX file from a friend or download one from the internet, your TomTom Rider can 

convert it into an Itinerary. You can then use the Itinerary to follow the route with navigational 

instructions. 
 

Converting a GPX file into an itinerary 

To convert a GPX file into an Itinerary, you can use one of the following two methods: 

Using Tyre 

1. Open the GPX file in Tyre. 

2. Click the button to copy the route to your TomTom Rider.  

Tyre converts the file to an Itinerary automatically. 
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Using manual conversion 

1. Connect your TomTom Rider to your computer. 

2. Place your GPX files in the GPX2ITN folder on your device. 

3. Disconnect your device from the computer. 

4. Turn your device on. 

Each file is then converted into an ITN file. You can convert up to 50 files in one batch. 

5. When the conversion has finished you can load your Itinerary. In the Main menu, tap Manage 

itineraries, then Open. 
 

About ITN files 

Contents 

This file contains less detail than the GPX file but it allows you to retrace your route using the Itin-

erary feature of your device. The ITN file can contain a maximum of 100 locations but that is 

enough to recreate a route accurately. 

Location 

ITN folder on your TomTom Rider. 

Using the file 

There are several things you can do with an ITN file: 

 You can load a recorded route onto your TomTom Rider so you can travel that same route 

again and get navigation instructions. 

 Share the file with other TomTom users by sending it using a Bluetooth connection. To do 

this, tap Manage itineraries in the Main Menu, followed by Share. 

Receiving an ITN file 

If you receive an ITN file, you can load it using your TomTom Rider.  

You can receive an ITN file in the following ways: 

 From a friend using Bluetooth. 

 Download one from the internet. 

 Copy one using Tyre. 

 Receive one using HOME. 
 

Loading an ITN file 

To load an ITN file, do the following: 

1. Tap the screen to bring up the Main Menu. 

2. Tap Manage itineraries. 

3. Tap Open. 

Tip: After loading a scenic route, if you are asked for a route type, select Shortest route to give 

you the closest representation of the original route. 

 

http://www.tyretotravel.com/
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Note: If you load an Itinerary that uses a map that is not on your device, the waypoints on the 

missing map appear crossed out and in orange. 
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About viewing the map 

You can view the map in the same way as you might look at a traditional paper map. The map 

shows your current location and many other locations such as Favorites and POIs. 

To view the map in this way, tap view map in the Main menu. 

You view different locations on the map by moving the map across the screen. To move the map, 

touch the screen and drag your finger across the screen.  

To select a location on the map, tap the location on the map. The cursor highlights the location 

and displays useful information about the location in an information panel. Tap the information 

panel to create a Favorite or plan a route to that location. 
 

View map 

 

1. The scale bar 

2. Marker 

A marker shows the distance to a location. Markers are colored as follows: 

 Blue - points to your current location. This marker is gray if you lose your GPS signal. 

View map 
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 Yellow - points to your home location. 

 Red - points to your destination.  

Tap a marker to center the map on the location pointed to by the marker. 

To turn markers off, tap Options, then Advanced and clear the Markers checkbox. 

3. Options button 

Tap this button to choose whether POIs, Favorites, names, markers and coordinates are 

shown. 

4. The cursor with street name balloon. 

5. The Find button 

Tap this button to find specific addresses, favorites or Points of Interest. 

6. The cursor button. 

Tap this button to plan a route to the cursor position, create a Favorite at the cursor position or 

find a Point of Interest near to the cursor position. 

7. The zoom bar 

Zoom in and out by tapping the glove-friendly buttons. 
 

Options 

Tap the Options button to set the information shown on the map and show the following infor-

mation: 

 Points of interest - select this option to show POIs on the map. Tap Choose POIs to choose 

which POI categories are shown on the map. 

 Favorites - select this option to show your Favorites on the map. 

Tap Advanced to show or hide the following information: 

 Markers - select this option to enable markers. Markers point to your current location (blue), 

your home location (yellow) and your destination (red). The marker shows the distance to the 

location. 

Tap a marker to center the map on the location the marker is pointing to. 

To disable markers, tap Options, then tap Advanced and deselect Markers. 

 Coordinates - select this option to show GPS coordinates in the lower left corner of the map. 

 Names - select this option to show street and city names on the map. 
 

Cursor menu 

The cursor can be used to do more than highlight a location on the map. 

Position the cursor on a location on the map, then tap the cursor menu button. Tap one of the 

following buttons: 

 

Navigate there 
 

Tap this button to plan a route to the cursor position on the map. 
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Find POI nearby 
 

Tap this button to find a POI near the cursor position on the map. 

For example, if the cursor currently highlights a restaurant location on 

the map, you can search for a nearby parking garage. 

 

Add as Favorite 
 

Tap this button to create a Favorite at the cursor position on the map. 

 

Add as POI 
 

Tap this button to create a POI at the cursor position on the map. 

 

Call... 
 

Tap this button to call the location at the cursor position. 

This button is only available if your TomTom Rider has the phone num-

ber for the location. 

The phone numbers for many POIs are available on your TomTom Rider. 

You can also call the phone numbers of your own POIs. 

 

Travel via... 
 

Tap this button to travel via the cursor position on the map as part of 

your current route. Your destination remains the same as before but your 

route now includes this location. 

This button is only available while there is a planned route. 
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About Map Share 

Map Share helps you correct map errors. You can correct several types of map error. 

To make corrections to your own map, tap Map corrections in the Options menu. 

Note: Map Share is not available in all regions. For more information, go to 

tomtom.com/mapshare. 
 

Correcting a map error 

Important: For safety reasons, do not enter the full details of a map correction while you are driv-

ing. Mark the location of the map error instead and enter the full details later. 

To correct a map error, do the following: 

1. Tap Map corrections in the Options menu. 

 

2. Tap Correct a map error. 

3. Select the type of map correction you want to apply. 

4. Select how you want to select the location. 

5. Select the location. Then tap Done. 

6. Enter the details of the correction. Then tap Done. 

7. Select whether the correction is temporary or permanent. 

8. Tap Continue. 

The correction is saved. 

 

 

 

 

Tip: You can add Mark location of map error to the Quick 

Menu. 

 
 

Types of map correction 

To make a correction to your map, tap Map corrections in the Options menu, then tap Correct a 

map error. There are several types of map correction available. 

Map corrections 

http://www.tomtom.com/mapshare
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(Un)block street 
 

Tap this button to block or unblock a street. You can block or unblock the 

street in one or both directions. 

For example, to correct a street near to your current location, do the 

following: 

1. Tap (Un)block street. 

2. Tap Near you to select a street near your current location. Alterna-

tively, you can select a street by name, a street near your Home loca-

tion or a street on the map. 

3. Select the street or section of a street you want to correct by tapping 

it on the map. 

The street you select is highlighted and the cursor shows the name 

of the street. 

4. Tap Done. 

Your device shows the street and whether the traffic is blocked or al-

lowed in each direction. 

 

5. Tap one of the direction buttons to block or unblock the flow of traffic 

in that direction. 

6. Tap Done. 

 

Reverse traffic 

direction 
 

Tap this button to correct the traffic direction of a one-way street, where 

the direction of traffic is different from the direction shown on your map. 

Note: Reverse traffic direction only works for one-way streets. If you 

select a two-way street you will be given the chance to block/unblock 

the street rather than changing the direction. 

 

Edit street name 
 

Tap this button to change the name of a street on your map. 

For example, to rename a street near to your current location: 

1. Tap Edit street name. 

2. Tap Near you. 

3. Select the street or section of a street you want to correct by tapping 

it on the map. 

The street you select is highlighted and the cursor shows the name 

of the street. 

4. Tap Done. 

Tip: If the highlighted section is not correct, tap Edit to change indi-
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vidual road sections. 

5. Type the correct street name. 

6. Tap Continue. 

 

Change turn re-

strictions 
 

Tap this button to change and report incorrect road turn restrictions. 

 

Change road speed 
 

Tap this button to change and report the road speed limit. 

 

Add or remove 

rotary 
 

Tap this button to add or remove a rotary. 

 

Add missing POI 
 

Tap this button to add a new Point of Interest (POI). 

For example to add a new restaurant near to your current location: 

1. Tap Add missing POI. 

2. Tap Restaurant in the list of POI categories. 

3. Tap Near you. 

You can select the location by entering the address or by selecting 

the location on the map. Select Near you or Near home to open the 

map at your current location or at your Home location 

4. Select the location of the missing restaurant. 

5. Tap Done. 

6. Type the name of the restaurant then tap Next. 

7. If you know the telephone number of the restaurant you can type it, 

then tap Next. 

If you don't know the number, just tap Next without typing a number. 

1. Tap Continue. 

 

Edit POI 
 

Tap this button to edit an existing POI. 

You can use this button to make the following changes to a POI: 

 Delete the POI. 

 Rename the POI. 

 Change the telephone number of the POI. 

 Change the category that a POI belongs to. 

 Move the POI on the map. 
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Comment on POI 
 

Tap this button to enter a comment about a POI. Use this button if you 

cannot edit the error with the POI using the Edit POI button. 

 

Correct house 

number 
 

Tap this button to correct the location of a house number. Enter the ad-

dress that you wish to correct and then indicate on the map the correct 

location of that house number. 

 

Existing street 
 

Tap this button to edit an existing street. Once you have selected the 

street, you can select an error to report. You can select more than one 

type of error for a street. 

 

Missing street 
 

Tap this button to report a missing street. You have to select the start 

and end points of the missing street. 

 

City 
 

Tap this button to report an error about a city, town or village. You can 

report the following types of error: 

 City is missing 

 Wrong city name 

 Alternative city name 

 Other 

 

Highway en-

trance/exit 
 

Tap this button to report an error about a highway entrance or exit. 

 

ZIP code 
 

Tap this button to report an error about a ZIP code. 

 

Other 
 

Tap this button to report other types of corrections. 

These corrections are not immediately applied to your map but are saved 

in a special report. 

You can report missing streets, errors in highway entrances and exits 

and missing rotaries. If the correction you want to report is not covered 

by any of these report types, enter a general description then tap Other. 
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About sounds and voices 

Your TomTom Rider device uses sound for some or all of the following: 

 Driving directions and other route instructions 

 Warnings that you set 

 Hands-free phone calls 

There are two types of voice available for your device: 

 Computer voices 

Computer voices are generated by your device. They provide route instructions and read 

aloud city and street names, and other useful information. 

 Human voices 

These are recorded by an actor and only provide route instructions. 
 

Sound and volume control 

To adjust the volume level, tap the left-hand section of the status bar in the Driving View. The last 

spoken instruction is repeated and the volume level is shown. Tap the glove-friendly plus and 

minus buttons to adjust the volume. 

Alternatively add Volume to the Quick Menu. 

Quick Menu option! 

 

To turn the sound on or off, tap sound in the Main Menu or add Switch sound on/off to the Quick 

Menu. 

Quick Menu option! 
 

Change voice 

 

Change voice 

 

 

Your navigation device is able to provide spoken instructions and warn-

ings using voices which are stored on the device. Some voices have 

been recorded by actors and other voices are computer-generated. 

The recorded voices are only used for spoken instructions while the 

computer voices are used for both spoken instructions and for reading 

aloud information stored on your map, such as street names. 

To select a different voice on your device, tap Change voice in the Voices 

menu. Then select a voice from the list. Computer voices are clearly 

Sounds and voices 
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marked. 

You can add and remove voices using TomTom HOME. 

Note: If you select a recorded voice, this will only be able to announce 

commands, but not street names. If you would like street names to be 

announced, you will need to select a computer voice. 

 

 
 

Disable voice / Enable voice 

 

Disable voice 
 

Tap this button to switch off voice guidance. You will no longer hear 

spoken route instructions, but you will still hear information such as traf-

fic information and warnings. 

Note: If you change the voice on your TomTom Rider, then voice 

guidance is automatically switched on for the new voice. 

 

Enable voice 

 
 

Tap this button to switch on voice guidance and hear spoken route in-

structions. 

 
 

Voice settings 

Tap Voices and then Voice preferences. You can then choose from the following options: 

Read early warning instructions 

Select the checkbox if you want to have early warning instructions read to you such as "ahead, 

turn left." 

Replace spoken instruction with a beep 

Choose whether you want the spoken instructions to be replaced with a beep always, never or 

above a certain speed. 

When you are talking on the phone, spoken instructions are always replaced with a beep so that 

you don’t have two voices talking to you at once. 
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About Points of Interest 

Points of Interest or POIs are useful places on the map.  

Here are some examples: 

 Restaurants 

 Hotels 

 Museums 

 Parking garages 

 Gas stations 

Note: Tap Map corrections in the Options menu to report missing POIs or edit existing POIs. 
 

Creating POIs 

Tip: For help on managing third party POIs, search for "Third party POIs" at: 

tomtom.com/support. 

1. Tap the screen to open the Main menu. 

2. Tap options. 

3. Tap Manage POIs. 

4. If there are no POI categories or the one you want to use does not exist, tap Add POI category 

and create a new category. 

 

Every POI must be assigned to a POI category. This means you need to have created at least 

one POI category before you can create your first POI. 

You can only add POIs to POI categories you have created. 

For more information on creating POI categories, read Managing POIs. 

5. Tap Add POI. 

6. Select the POI category you want to use for the new POI. 

7. Tap a button to enter the POI address in the same way that you plan a route. 

The POI is created and saved in the selected category. 

 

Home 
 

Tap this button to set your Home location as a POI. 

This is useful if you decide to change your Home location but first 

want to create a POI using the current Home address. 

Points of Interest 

http://www.tomtom.com/
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Favorite 
 

Tap this button to create a POI from a Favorite. 

You might want to create a POI from a Favorite because you can only 

create a limited number of Favorites. If you want to create more Fa-

vorites you need to delete some Favorites. To avoid losing a Favor-

ite, save the location as a POI before you delete the Favorite. 

 

Address 
 

Tap this button to enter an address as a new POI. 

When you enter an address, you can choose from four options. 

 City center 

 Street and house number 

 ZIP code 

 Cross street or intersection 

 

Recent destination 
 

Tap this button to select a POI location from a list of places you have 

recently used as destinations. 

 

Point of Interest 
 

Tap this button to add a Point of Interest (POI) as a POI. 

For example, if you are creating a category of POIs for your favorite 

restaurants, use this option instead of entering the addresses of the 

restaurants. 

 

My location 
 

Tap this button to add your current location as a POI. 

For example, if you stop somewhere interesting, you can tap this 

button to create a new POI at the current location. 

 

Point on map 
 

Tap this button to create a POI using the map browser. 

Use the cursor to select the location of the POI, then tap Done. 

 

Latitude Longitude 
 

Tap this button to create a POI by entering latitude and longitude 

values. 

 
 

Using POIs to plan a route 

When you plan a route, you can use a POI for the destination. 

The following example shows how to plan a route to a parking lot in a city: 

1. Tap Plan route in the Main menu. 

2. Tap Point of Interest. 

3. Tap POI in a city. 

Tip: The last POI you viewed on your TomTom Rider device is also shown in the menu. 
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4. Enter the name of the town or city and select it when it is shown in the list. 

5. Tap the arrow button to expand the list of POI categories. 

Tip: If you already know the name of the POI you want to use, you can tap Search by name 

to enter the name and select this location. 

6. Scroll down the list and tap Parking lot. 

7. The parking lot closest to the city center is shown at the top of the list. 

8. The following list explains the distances shown next to each POI. How the distance is meas-

ured varies depending on how you initially searched for the POI: 

 POI near you - distance from your current location 

 POI in a city - distance from the city center 

 POI near Home - distance from your Home location 

 POI along route - distance from your current location 

 POI near destination - distance from your destination 

9. Tap the name of the parking lot you want to use and tap Done when the route has been calcu-

lated. 

Your device starts to guide you to the parking lot. 
 

Showing POIs on the map 

You can select the types of POI locations you want to see on your maps. 

1. Tap Manage POIs in the Options menu. 

2. Tap Show POI on map. 

3. Select the categories you want to be shown on the map. 

4. Tap Done. 

The types of POI you have selected are shown as symbols on the map. 
 

Calling a POI 

Many of the POIs on your TomTom Rider device include phone numbers. This means that you can 

use your device to call the POI and plan a route to the location of the POI. 

Important: You should only call a POI when you are parked. 

For example, you can search for a movie theater, call to book a ticket and plan a route to the 

movie theater, and all using your TomTom Rider device. 

1. Tap options. 

2. Tap Mobile phone. 

3. Tap Call... 

4. Tap Point of Interest. 

5. Select how you want to search for the POI. 

For example, if you want to search for a POI on your route, tap POI along route. 

6. Tap the type of POI you want to call. 

For example, if you want to call a cinema to reserve a ticket, tap Cinema and then select the 

name of the cinema you want to call. Then tap Call to make the phone call. 
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Your TomTom Rider uses your mobile phone to call the POI. 
 

Setting warnings for POIs 

You can set a warning sound to be played when you approach a selected type of POI, such as a 

gas station. 

The following example will show how to set a warning sound to be played when you are 250 me-

ters from a gas station. 

1. In the Options menu, tap Manage POIs and then tap Warn when near POI. 

2. Scroll down the list and tap Gas station. 

Tip: To remove a warning, tap on the category name and then tap Yes. POI categories which 

have been set with a warning have a sound symbol next to the category name. 

3. Set the distance as 250 yards and tap OK. 

4. Select Sound effect and then tap Next. 

5. Select the warning sound for the POI and then tap Next. 

6. If you only want to hear the warning when the POI is directly on a planned route, select Warn 

only if POI is on route. Then tap Done. 

The warning is set for the selected POI category. You will hear a warning sound when you are 

250 yards from a gas station on your route. 
 

Manage POIs 

Tap Manage POIs to manage your POI categories and locations. 

 

You can set your TomTom Rider device to let you know when you are near to selected POI loca-

tions. In this way you could, for example, set the device to let you know you when you are ap-

proaching a gas station. 

You can create your own POI categories and add your own POI locations to these categories. 

This means you can, for example, create a new POI category called Friends. You could then add 

all your friends' addresses as POIs in this new category. 

Tap the following buttons to create and maintain your own POIs: 

 Add POI - tap this button to add a location to one of your own POI categories. 

 Warn when near POI - tap this button to set your device to warn you when you are near se-

lected POIs. 

 Delete POI - tap this button to delete one of your own POI categories. 

 Edit POI - tap this button to edit one of your own POIs. 

 Add POI category - tap this button to create a new POI category. 

 Delete POI category - tap this button to delete one of your own POI categories. 
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About hands-free calls 

If you have a mobile phone with Bluetooth®, you can use your TomTom Rider to make phone 

calls and send and receive messages. 

Important: Not all phones are supported or compatible with all features. For more information, go 

to tomtom.com/phones/compatibility. 
 

Using a headset 

We recommend using a compatible headset with your TomTom Rider to hear spoken instructions, 

make and receive hands-free phone calls and hear warning sounds on your TomTom Rider. This 

makes riding with your TomTom Rider as safe as possible. For more information and a full list of 

compatible headsets, go to tomtom.com/riderheadsets. 

The instructions below describe how to set up a Bluetooth® headset. If you did not establish a 

Bluetooth connection between your Bluetooth headset and your TomTom Rider when you first 

turned your TomTom Rider on, you can establish the connection at any time by doing the follow-

ing: 

1. Turn the headset on or off by following the instructions for your particular brand of headset.  

2. From the Main Menu, tap options.  

3. Tap Connect to headset and follow the instructions to establish the connection. 

4. Attach your headset to your helmet.  

Make sure you position the microphone correctly. For best results, don’t position the micro-

phone directly in front of your mouth, position it just to the side of your mouth. 

An image of the parts of a typical headset is shown below: 

 

 

1. Microphone 

Hands-free calling 

http://www.tomtom.com/phones/compatibility
http://www.tomtom.com/riderheadsets
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2. On/Off button 

3. Speakers 

4. LED 

5. Volume down 

6. Volume up 

7. Charging connector 

Before you can use your Bluetooth headset, fully charge the headset using the charger supplied 

with the headset. 
 

Connecting to your phone 

Important: To hear voice instructions, hands-free calls or warning sounds, you need to use a 

compatible headset with your TomTom Rider. For more information and a full list of compatible 

headsets, go to tomtom.com/riderheadsets. 

First you must establish a connection between your mobile phone and your TomTom Rider. 

Tip: Do not pair your headset with your mobile phone. If you do this you will not be connected 

to your TomTom Rider and will not hear any navigation instructions. 

Tap Mobile phone in the Options menu. Tap Manage phones and select your phone when it is 

shown in the list. 

You only need to do this once, and your TomTom Rider will remember your phone. 

Tips 

 Make sure that you switch on Bluetooth® on your phone. 

 Make sure that your phone is set to "discoverable" or "visible to all." 

 You may have to enter the password "0000" on your phone in order to connect to your 

TomTom Rider. 

 To avoid having to enter "0000" every time you use the phone, save your TomTom Rider as a 

trusted device on your phone. 

For additional information about Bluetooth settings, refer to your mobile phone user guide. 
 

Your Phone Book 

You can copy your mobile phone address book to your TomTom Rider. 

Tip: To copy the phonebook from your mobile phone to your TomTom Rider, tap Get numbers 

from phone. 

Not all phones can transfer the phonebook to your TomTom Rider. For more information, go to 

tomtom.com/phones/compatibility. 
 

Making a call using speed dial 

When you have established a connection between your TomTom Rider and your mobile phone, 

you can use your TomTom Rider to make hands-free calls on your mobile phone. 

http://www.tomtom.com/riderheadsets
http://www.tomtom.com/phones/compatibility
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Quick Menu option! 

To set up a speed dial number that is accessible from the Driving View, do the following: 

1. Tap Quick menu preferences in the Options menu 

2.  Tap Call... 

This displays the button in the Driving View. 

3. Choose your speed dial number by tapping one of following buttons:  

 Tap Home to use your home number as your speed dial number. 

If you have not entered a number for your home location this button is unavailable. 

 Tap Phone number to enter a phone number to use as your dial number. 

 Tap Point of Interest to choose a POI number as your speed dial number. 

If your device knows the phone number of a POI, this is shown next to the POI. 

 Tap Phonebook entry to select a contact from your phonebook. 

Note: Your phonebook is automatically copied to your TomTom Rider  when you first 

establish a connection with your mobile phone. 

Not all phones can transfer the phonebook to your device. For more information, go to 

tomtom.com/phones/compatibility. 

 Tap Recently dialed to select from a list of people or numbers you have called recently to 

use as your speed dial number. 

 Tap Recent caller to select from a list of people or numbers who called you recently. 

Only calls you have received on your device are saved in this list. 

4. To use your speed dial number after you've set it up, tap the phone button in the Driving View. 
 

Making a Call 

When you have established a connection between your TomTom Rider and your mobile phone, 

you can use your TomTom Rider to make hands-free calls on your mobile phone. 

To make a phone call without using speed dial, do the following: 

1. Tap options. 

2. Tap Mobile phone. 

3. Tap Call... 

4. Then tap one of the following buttons: 

 Tap Home to call your Home location.  

If you have not entered a number for your Home location this button is unavailable.  

 Tap Phone number to enter a phone number to call. 

 Tap Point of Interest to choose a Point of Interest (POI) to call. 

If your device knows the phone number of a POI, this is shown next to the POI. 

 Tap Phonebook entry to select a contact from your phonebook. 

Note: Your phonebook is automatically copied to your TomTom Rider when you first es-

tablish a connection with your mobile phone. 

http://www.tomtom.com/phones/compatibility
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Not all phones can transfer the phonebook to your device. For more information, go to 

tomtom.com/phones/compatibility. 

 Tap Recently dialed to select from a list of people or numbers you have called recently 

using your device. 

 Tap Recent caller to select from a list of people or numbers who called you recently. 

Only calls you have received on your device are saved in this list. 
 

Receiving a call 

When someone calls you, the caller's name and phone number are shown. Tap the screen to ac-

cept or reject the call. 

 

Tip: When you receive a call, the Driving View is automatically shown so you can keep seeing 

instructions. During a phone call you hear beeps instead of the actual instructions. This is so 

that you don’t have two voices talking to you at once. 
 

Auto-answer 

You can set your TomTom Rider device to automatically answer incoming phone calls. 

To set automatic answering, tap Mobile phone in the Options menu, then tap Phone preferences. 

Tap Auto-answer preferences. 

Select how long your device will wait before automatically answering your calls, then tap Done. 
 

Connecting more phones to your device 

You can establish connections for up to 5 mobile phones. 

To add more phones, do the following. 

1. Tap Mobile phones in the Options menu. 

2. Tap Manage phones. 

3. Tap Find another phone and follow the instructions. 

To switch between phones, tap Manage phones. Then tap the button for the phone you want to 

connect to. 
 

http://www.tomtom.com/phones/compatibility
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Mobile phone menu 

Tap options and then tap Mobile phone to use the following options: 

 

Call 
 

Quick Menu option! 

Tap this button to make a phone call using your mobile phone. 

This button also appears in the Driving View while a call is active. Tap 

this button in the Driving View to open the Call menu where you can see 

the details of the caller or end the call. 

 

REDIAL 
 

Tap this button to redial a telephone number using your mobile phone. 

 

Manage phones 
 

Tap this button to manage the mobile phones that will be connected to 

your TomTom Rider.   

You can add a profile for up to five different mobile phones. 

 

Phone preferences 
 

Tap this button to configre how your  TomTom Rider communicates 

with your mobile phone. 

 

Get numbers from 

phone 
 

Tap this button to load the contacts and phone numbers from your mo-

bile phone onto your TomTom Rider. 

Important: Not all phones are supported or compatible with all features. 
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About Favorites 

Favorites provide an easy way to select a location without the need to enter the address. They do 

not need to be favorite places, they can simply be seen as a collection of useful addresses. 
 

Creating a Favorite 

To create a Favorite, do the following: 

1. Tap the screen to bring up the Main menu. 

2. Tap options. 

3. Tap Home and Favorites. 

4. Tap Add Favorite. 

5. Select the type of the Favorite by tapping one of the buttons described below: 

Tip: You can type your own name for the Favorite when the keyboard is shown. To enter the 

name, there’s no need to delete the suggested name, just start typing. 

 

 

Home 
 

You can set your Home location as a Favorite. 

 

Favorite 
 

You cannot create a Favorite from another Favorite. This option will al-

ways be unavailable in this menu. 

To rename a Favorite, tap Home and Favorites then Rename Favorite in 

the Options menu. 

 

Address 
 

You can enter an address as a Favorite. 

 

Recent destination 
 

Create a new Favorite by selecting a location from a list of your recent 

destinations. 

 

Point of Interest 
 

If you visit a POI you particularly like, for example a restaurant, you can 

add it as a Favorite. 

 

To add a POI as a Favorite, tap this button, then do the following: 

Favorites 
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1. Narrow your choice of POIs by selecting the area where the POI is. 

You can select one of these options: 

 POI near you - to search from a list of POIs near your current po-

sition. 

 POI in a city - to choose a POI in a particular town or city. You 

have to specify a town or city. 

 POI near Home - to search from a list of POIs near your Home 

location. 

If you are currently navigating to a destination, you can also select 

from a list of POIs which are on your route or near your destination. 

Choose one of these options: 

 POI along route 

 POI near destination 

2. Select the category of POI. 

Tap the category of POI if it is shown or tap the arrow to choose from 

the complete list. 

Tap Any POI category to search for a POI by name. 

 

My location 
 

Tap this button to add your current location as a Favorite. 

For example, if you stop somewhere interesting, while you are there you 

can tap this button to create the Favorite. 

 

Point on map 
 

Tap this button to create a Favorite using the Map Browser. 

Select the location of the Favorite using the cursor, then tap Done. 

 

Latitude Longitude 
 

Tap this button to create a Favorite by entering latitude and longitude 

values. 

 
 

Using a Favorite 

You can use a Favorite as a way of navigating to a place without having to enter the address. To 

navigate to a Favorite, do the following: 

1. Tap the screen to bring up the Main menu. 

2. Tap Plan route or Change route. 

3. Tap Favorite. 

4. Select a Favorite from the list. 

Your TomTom Rider device calculates the route for you. 

5. When the route is calculated, tap Done. 



62 

 

 

 

Your device immediately starts guiding you to your destination with spoken instructions and visual 

instructions on the screen. 
 

Changing the name of a Favorite 

To change the name of a Favorite, do the following: 

1. Tap the screen to bring up the Main menu. 

2. Tap options. 

3. Tap Home and Favorites. 

4. Tap Rename Favorite. 

5. Tap the Favorite you want to rename. 

Tip: Use the left and right arrows to choose another Favorite from your list. 

6. Tap Rename. 

7. Type in the new name and then tap OK. 

8. Tap Done. 
 

Deleting a Favorite 

To delete a Favorite, do the following: 

1. Tap the screen to bring up the Main menu. 

2. Tap options. 

3. Tap Home and Favorites. 

4. Tap Delete Favorite. 

5. Tap the Favorite you want to delete. 

Tip: Use the left and right arrows to choose another Favorite from your list. 

6. Tap Delete. 

7. Tap Yes to confirm the deletion. 

8. Tap Done. 
 

Change Home location 

 

Home location 

 

 

Tap this button to set or change your Home location. You enter the ad-

dress in the same way as you do when you plan a route. 

Your Home location provides an easy way to plan a route to an important 

location. 

For most people, your Home location will be your home address. How-

ever, you might prefer to set the location to another regular destination, 

such as your place of work. 

Quick Menu option! 

Once a home location has been set, you can choose Home as part of 

your Quick Menu. 
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About Options 

You can change the way your TomTom Rider looks and behaves. 

Tap options in the Main Menu. 
 

Battery saving 

 

Battery saving 

 

 

To change the power saving settings, tap this button on your device. 

 
 

Brightness preferences 

 

Brightness prefer-

ences 

 

 

Tap this button to set the brightness of the screen.  

Move the sliders to set the brightness separately for day map colors and 

for night map colors. 

You can also set this option: 

 Switch to night colors when dark - your TomTom Rider uses a light 

sensor to detect the background light level. If this option is selected, 

when it gets dark, your TomTom Rider uses night colors for the 

Driving View. 

 
 

Change map colors 

 

Change map colors 

 

 

Tap this button to select the color schemes for day and night map colors. 

Tap Advanced to scroll through color schemes one at a time. 

You can also download more color schemes using TomTom HOME. 

 
 

Change vehicle symbol 

 

Change vehicle 

symbol 

 

 

Tap this button to select the vehicle symbol that shows your current 

location in the Driving View. 

Additional symbols can be downloaded using TomTom HOME. 

Options 
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Connect to headset 

 

Connect to headset 

 

 

Tap this button to setup and connect your headset to your navigation 

device. 

 
 

Safety Alerts menu 

Important: Outside of France, you receive warnings about speed cameras. Inside France, you 

receive warnings about danger zones. When you cross the border, the type of warning you re-

ceive changes. 

To open the Danger zones menu, tap options in the Main Menu and then tap Danger zones. 

 

Report danger 

zone 
 

Tap this button to report a new danger zone location. 

 

Change warning 

preferences 
 

Tap this button to set when you receive warnings and the sound. 

 

Disable danger 

zones 
 

Tap this button to disable warnings. 

 

Enable report but-

ton 
 

Tap this button to enable the report button. The report button is shown in 

the Driving View or in the Quick Menu. 

When the report button is shown in the Driving View, this button chang-

es to Disable report button. 

 
 

Help me 

 

Help me 

 

 

Quick Menu option! 

You can use Help me to plan a route to local services, make contact by 

phone and inform the service about the precise details of your current 



65 

 

 

 

location. 

Tap Phone for help to view the location and contact details for a service. 

Tap Drive to help to plan a route by bike to a service. 

 
 

Home and Favorites 

 

Home and Favor-

ites 

 

 

Tap this button to manage your Home and Favorite locations. 

For more information, see About Favorites. 

 
 

Keyboard preferences 

 

Keyboard prefer-

ences 

 

 

You use the keyboard to enter your destination or to find an item in a list, 

such as a POI. 

Tap this button to select left or right-handed use, the type of keyboard 

characters you want to use, the size of the keys and the keyboard layout. 

First choose whether you want to operate the keyboard using your left or 

right hand. 

Then select the type of keyboard from the following options: 

 

Thirdly, if you selected a Latin keyboard, choose between glove-friendly 

buttons or a range of keyboard layouts: 

 Use glove friendly keyboard (big buttons) 

 Use ABCD, QWERTY, AZERTY or QWERTZ keyboard 

If you choose the glove-friendly keyboard, you see large buttons when 

entering addresses: 
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Language 

 

Language 

 

 

Tap this button to change the language used for all the buttons and 

messages you see on your device. 

You can choose from a wide range of languages. When you change the 

language, you are also given the opportunity to change the voice. 

 
 

Manage POIs 

 

Manage POIs 

 

 

Tap this button to manage your own Point of Interest (POI) categories 

and locations. 

You can set your TomTom Rider device to let you know when you are 

near to selected POI locations. For example, you could set the device to 

let you know when you are approaching a gas station. 

You can create your own POI categories and add your own POI locations 

to these categories. 

You can, for example, create a new POI category called Friends. You 

could then add all your friends' addresses as POIs in this new category. 

You can even add your friends’ phone numbers with their address so 

you can call them from your TomTom Rider. 

Tap the following buttons to create and maintain your own POIs: 

 Show POI on map - tap this button to select the categories of POI 

shown on the map when riding. 

 Warn when near POI - tap this button to set your device to warn you 

when you are near selected POIs. 

 Add POI - tap this button to add a location to one of your own POI 

categories. 

 Delete POI - tap this button to delete a POI. 

 Edit POI - tap this button to edit one of your own POIs. 

 Add POI category - tap this button to create a new POI category. 

 Delete POI category - tap this button to delete one of your own POI 

categories. 
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Note: To hear spoken instructions, hands-free phone calls and warn-

ing sounds on your TomTom Rider, you need to use a compatible 

headset. For more information and a full list of compatible headsets, 

go to tomtom.com/riderheadsets. 

 
 

Map corrections 

 

Map corrections 

 

 

Tap this button to correct errors on your map. 

 

 
 

Mobile phone menu 

Tap options and then tap Mobile phone to use the following options: 

 

Call 
 

Quick Menu option! 

Tap this button to make a phone call using your mobile phone. 

This button also appears in the Driving View while a call is active. Tap 

this button in the Driving View to open the Call menu where you can see 

the details of the caller or end the call. 

 

REDIAL 
 

Tap this button to redial a telephone number using your mobile phone. 

 

Manage phones 
 

Tap this button to manage the mobile phones that will be connected to 

your TomTom Rider.   

You can add a profile for up to five different mobile phones. 

 

Phone preferences 
 

Tap this button to configre how your  TomTom Rider communicates 

with your mobile phone. 

http://www.tomtom.com/riderheadsets
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Get numbers from 

phone 
 

Tap this button to load the contacts and phone numbers from your mo-

bile phone onto your TomTom Rider. 

Important: Not all phones are supported or compatible with all features. 
 

Planning preferences 

 

Planning prefer-

ences 

 

 

Tap this button to set the kind of route planned when you select a desti-

nation.  

The following options are available: 

 Ask me every time I plan 

 Always plan fastest routes 

 Always plan shortest routes 

 Always plan eco routes 

 Always avoid highways 

 Always plan walking routes 

 Always plan bicycle routes 

Replanning preferences 

Select whether or not you want your TomTom Rider to replan your route when a faster route is 

found while you drive. This might occur due to changes in the traffic situation. 

Although your TomTom Rider cannot connect to a traffic receiver, it can still use measurements 

for average traffic speeds in your map from IQ Routes. 

Planning for road types and crossings 

Then set how your TomTom Rider should handle the following when planning a route: 

 Toll roads on the route 

 Ferry crossings on the route 

 HOV lanes on the route 

 Carpool lanes 

 Unpaved roads 

You can then set if the route summary screen closes automatically after you have planned a route. 

If you select No, you have to tap Done to close the route summary screen. 
 

Quick Menu preferences 

 

Quick Menu pref-

erences 

 

 

Tap this button to choose the options for easy access using the Quick 

Menu button in Driving View. Some of the options available are: 

 Gas station 

 Call.... 

 Continue Itinerary 

 Report speed camera 

 Trip statistics for today 
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For more information, see About the Quick Menu in this guide. 

 
 

Reset factory settings 

 

Reset factory set-

tings 

 

 

Tap this button to delete all your personal settings and restore the stand-

ard factory settings to your TomTom Rider device. 

This is not a software update and will not affect the version of the soft-

ware application installed on your device. 

Important: This feature deletes all your personal settings! 

If you want to keep your personal information and settings, you should 

perform a full backup of your device before you reset the device. You 

can then restore all your personal information and settings after you 

reset the device. 

This includes items such as your Home and Favorite locations, your per-

sonal menu and your POI categories and POI locations. 

 
 

Safety warnings 

 

Safety warnings 

 

 

Tap this button to select the safety features you want to use on your 

device. 

 
 

Set clock 

 

Set clock 

 

 

Tap this button to select the time format and to set the time. 

The easiest way to set the time is by tapping the Sync button. Your 

TomTom Rider will then take the time from GPS information. 

Note: You can only use Sync if you have GPS reception, so you can-

not set the clock in this way when you are indoors. 

After using Sync to set the time, you may have to adjust the hours 

depending on your time zone. Your TomTom Rider works out your 

time zone and always keeps the time correct using GPS information. 

 
 

Show compass 

 

Show / hide com-

pass 

 

 

Tap this button to show or hide the compass in the Driving View. 

The compass always shows the direction you are traveling. For example, 

if it points to the right, you are traveling to the East. 
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Speed Cameras menu 

To open the Speed Cameras menu, tap options in the Main Menu and then tap Speed Cameras. 

 

Report speed cam-

era 
 

Quick Menu option! 

Tap this button to report a new speed camera location. 

 

Change warning 

preferences 
 

Tap this button to set the warnings you will receive and the sounds used 

for each warning. 

 

Disable speed 

cameras 
 

Tap this button to disable warnings. 

 

Enable report but-

ton 
 

Tap this button to enable the report button. The report button is shown in 

the Driving View or in the Quick Menu. 

When the report button is shown in the Driving View, this button chang-

es to Disable report button. 

 
 

Start or Stop recording 

 

Start recording 
 

Tap this button to start recording your route. 

As your TomTom Rider moves along on your bike, it records your posi-

tion every few seconds. During recording, you can continue to use your 

TomTom Rider as normal. You can safely turn your device off and on 

during recording. 

For more information, see About recording your route. 

 

 

Stop recording 
 

Tap this button to stop recording your route. 

For more information,  see About recording your route. 
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Start up 

 

Start up 

 

 

Tap this button to set what happens when your device starts. 

 

 

 

Status & infor-

mation 

 

 

Tap this button to find technical information about your TomTom Rider. 

 
 

Status bar preferences 

 

Status bar prefer-

ences 

 

 

Tap this button to select the information you want to see on the status 

bar: 

 Horizontal - show the status bar at the bottom of the Driving View. 

 Vertical - show the status bar on the right-hand side of the Driving 

View. 

 Current time 

 Current speed 

 Maximum speed - only available when speed (above) is also select-

ed. 

 Leeway to arrival time - the leeway is the difference between your 

preferred arrival time and your estimated arrival time.  

Important: The speed limit is shown next to your current speed. If you 

drive faster than the speed limit, you see a warning indicator in the status 

bar, for example the status bar pane turns red. Information about speed 

limits is not available for all roads. 

 Arrival time - your estimated arrival time. 

 Remaining time - the estimated time left until you reach your desti-

nation. 

 Remaining distance - the distance to your destination. 

 Lane guidance - If you choose this option, your device shows the 

lane you should take in the status bar for some exits and junctions. 
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Street name settings 

  

Street name pref-

erences 

 

 

Tap this button to set the information that is shown on the map in the 

Driving View. The following options are available: 

 Show house number before street name 

 Show street names - if you are using a computer voice for spoken 

instructions and have selected that street names should be read 

aloud, you do not need to select this option, since the street names 

will be read aloud even though this option is not selected. 

 Show next street name 

 Show current street name on map 

 
 

Switch map 

 

Switch map 

 

 

Tap this button to change the map you are using.  

 
 

Trip statistics 

 

Trip statistics 

 

 

Tap this button to view a selection of trip statistics. 

When you first tap the button, you see statistics for today’s riding. 

Tap the arrow to see statistics from your most recent trip. Tap it again to 

see a total of statistics since you started your device. 

Tap New trip to reset the tool for a new trip. 

 

 

 

 

Tip: To easily view your current trip statistics, choose Trip statistics 

for today as part of your Quick Menu. 

 

 

 
 

Units 

 

Units 

 

 

Tap this button to set the units used on your device for features such as 

route planning. 
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Use night colors / Use day colors 

 

Use night colors 
 

Quick Menu option! 

Tap this button to reduce the brightness of the screen and display the 

map in darker colors. 

When riding at night or when riding through a dark tunnel, it is easier to 

view the screen and less distracting for the driver if the brightness of the 

screen is dimmed. 

You can download additional color schemes using TomTom HOME. 

 

Use day colors 
 

Quick Menu option! 

Tap this button to increase the brightness of the screen and display the 

map in brighter colors. 

You can download additional colour schemes using TomTom HOME. 

 
 

Voices 

 

Voices 

 

 

Tap Voices to manage your TomTom voices. The following options are 

available: 

 Change voice - tap this button to change the voice that gives you 

instructions. 

A wide range of recorded human voices and computer voices are 

available. 

 Disable voice - tap this button to disable voice guidance. 

 Enable voice - tap this button to enable voice guidance. 

 Voice preferences - tap this button to choose the situations when 

your TomTom navigation device reads instructions or warnings 

aloud. 

Note: To hear spoken instructions, hands-free phone calls and warn-

ing sounds on your TomTom Rider, you need to use a compatible 

headset. For more information and a full list of compatible headsets, 

go to tomtom.com/riderheadsets. 

 
 

Winding route preference 

 

Winding route 

preference 

 

 

Tap this button to choose the extent to which minor or major roads are 

part of your route. 

Move the slider to the left to include more winding roads. 

 

http://www.tomtom.com/riderheadsets
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About Speed Cameras 

The Speed Cameras service warns you about the following roadside camera locations: 

 Speed Camera locations. 

 Dangerous roads. 

 Speed trap locations. 

 Average speed camera locations. 

 Traffic light camera locations. 

Note: In France, no warnings are given for individual cameras or different types of camera. It is 

only possible to warn about danger zones. Danger zones are areas where there may be camer-

as. It's possible to report or confirm the location of danger zones, but it's not possible to remove 

them. 

 

Important: Regularly connect your navigation device to the TomTom HOME to update the list of 

locations for fixed cameras and black spots. 
 

Subscribing to this service 

The Speed Cameras service is a subscription service that you can join using the TomTom website 

at tomtom.com. 

To download the latest fixed speed camera locations to your navigation device, connect your 

device to your computer and start TomTom HOME. 
 

Updating locations for alerts 

The locations of speed cameras can change frequently. New cameras can also appear without 

warning and the locations for other alerts, such as dangerous roads, may also change position. 

As a result, you may want to have the latest list of camera and alert locations on your device be-

fore you start a journey. 

To ensure that you have the latest list, connect your TomTom Rider to your computer shortly be-

fore you begin each trip. Start TomTom HOME to update and your device is then updated with all 

the latest fixed alert locations. 
 

Speed Camera warnings 

By default, warnings are given 15 seconds before you reach a speed camera location. To change 

the number of seconds or warning sound, tap Change warning preferences in the Speed Cameras 

menu. 

You are warned in three ways: 

Speed Cameras 

http://www.tomtom.com/
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 Your device plays a warning sound. 

 The type of speed camera and your distance from the camera location is shown in the Driving 

View. If a speed restriction has been reported for the camera, the speed is also shown in the 

Driving View. 

 The location of the speed camera is shown on the map. 

Note: For speed enforcement zone cameras, you are warned by a combination of icons and 

sounds at the start, middle and end of the Speed Enforcement Zone. 
 

Changing the way you are warned 

 

Change warning 

preferences 

 

 

To change the way your TomTom Rider warns you about speed camer-

as, tap the Change warning preferences button. 

You can then set how close you want to be to a speed camera before 

you are warned and what type of sound will be played. 

For example, to change the sound that is played when you approach a 

fixed speed camera, do the following: 

1. Tap options in the Main Menu. 

2. Tap Speed Cameras. 

3. Tap Change warning preferences. 

A list of speed camera types is displayed. A speaker is shown next to 

the speed camera types that have been set for an alert. 

4. Tap Fixed speed cameras. 

5. Tap NO to keep the fixed safety camera alerts. 

6. Enter the time in seconds for when a warning is given before you 

reach a camera. Then tap Next. 

7. Tap the sound you want to be used for the warning. 

Tips: To switch off warning sounds for a camera type, tap Silence in 

step 7 above. You still see a warning in the Driving View if you 

switch off the warning sound. 

8. Tap YES to save your changes. 

 
 

Safety camera symbols 

Safety cameras are shown as symbols on the Driving View. 

As you approach a camera, you see a symbol showing the kind of camera and the distance to the 

camera. A warning sound is played. You can change the warning sound for cameras or turn 

warning sounds on and off for each camera.  

Tap the camera symbol to report that the camera is no longer there or to confirm that it is still 

there. 

Note: In France, to comply with French law we only warn you about danger zones. It's possible 

to report or confirm the location of a Danger Zone, but it's not possible to remove them. 

When you first start using your device, warning sounds are played for these types of cameras: 
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Fixed safety camera - this type of camera checks the speed of passing 

vehicles and is fixed in one place. 

 
 

Temporary camera - this type of camera checks the speed of passing 

vehicles and is moved to different places. 

 
 

Red light camera - this type of camera checks for vehicles breaking traffic 

rules at traffic lights. 

 
 

Average speed check - these types of cameras measure your average 

speed between two points. You are warned at the start and end of the 

average speed check area. 

While you are driving in an average speed check area, your average 

speed is shown, instead of your current speed. 

When you are in the speed check area, the visual warning continues to 

be shown in the Driving View. 

 
 

Danger zone - this type of warning is only given in France where you are 

only warned about danger zones. Danger zones include all other types of 

warnings. 

 
 

Accident black spot 

 
 

Ungated railway crossing 

When you first start using your device, no warning sounds are played for these types of cameras: 
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Restricted road camera 

 
 

Other camera 

 
 

Mobile camera hotspot - this type of warning shows places where mo-

bile cameras are often used. 

 
 

Bidirectional camera 

 
 

Report button 

To show the report button in the Driving View, do the following: 

1. Tap options in the Main Menu. 

2. Tap Speed Cameras. 

3. Tap Enable report button. 

4. Tap Done. 

The report button is shown on left-hand side of the Driving View or, if you are already using 

the Quick Menu, it's added to the buttons available in the Quick Menu. 

Quick Menu option! 

Tip: To hide the report button, tap Disable report button in the Speed Cameras menu. 
 

Reporting a new speed camera while on the move 

To report a speed camera on the move, do the following: 

1. Tap the report button shown in the Driving View or in the quick menu to record the location of 

the camera. 

2. Confirm that you want to add a camera. 
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You see a message thanking you for adding the camera. 

Note: It's possible to report or confirm the location of danger zones, but it's not possible to re-

move them. 
 

Reporting a new speed camera while at home 

You do not need to be at the location of a speed camera to report the new location. To report a 

new speed camera location while you are at home, do the following: 

1. Tap options in the Main Menu. 

2. Tap Speed Cameras. 

3. Tap Report speed camera. 

4. Tap Fixed camera or Speed trap depending upon the type of speed camera. 

5. Use the cursor to mark the exact location of the camera on the map, then tap Done. 

6. Tap Yes to confirm the location of the camera. 

7. Tap on the type of camera you want to report and if necessary, choose the speed restriction 

for the camera. 

You see a message confirming that a report has been created. 
 

Reporting incorrect camera alerts 

You may receive an alert for a camera that is no longer there. To report an incorrect camera alert, 

do the following: 

Note: You can only report an incorrect camera alert while you are at the location. 

1. While you are at the location of the missing camera, tap Report in the Driving View. 

Note: This must be done within 20 seconds of receiving the camera alert. 

2. Tap Remove. 

Note: It's possible to report or confirm the location of danger zones, but it's not possible to re-

move them. 
 

Types of fixed speed camera you can report 

When you report a fixed speed camera, you can select the type of fixed camera you are reporting. 

These are the different types of fixed speed camera: 

 

Speed Camera 
 

This type of speed camera checks the speed of passing vehicles. 

 

Red light camera 
 

This type of camera checks for vehicles breaking traffic rules at traffic 

lights. 
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Toll booth speed 

camera 
 

This type of camera monitors traffic at toll road barriers. 

 

Speed Enforce-

ment Zone 
 

This type of speed camera checks the average speed of vehicles be-

tween two fixed points. 

 

Vehicle restriction 
 

This type of camera checks traffic on roads where access is restricted. 

 

Other cameras 
 

All other types of cameras that do not fall into any of the above catego-

ries. 

 
 

Speed Enforcement Zone warnings 

There are several types of visual and audible warnings that you may see and hear when you meet 

a speed enforcement zone camera. 

You always receive a start and end zone warning regardless of the speed you are traveling at.  

Intermediate warnings, if given, occur every 200 meters. 

All the warnings are described below: 

 
 

Start of zone warning 

As you approach the start of a Speed Enforcement Zone, you see a visu-

al warning in the top left hand corner of the Driving View with a distance 

to the camera underneath it. You hear an audible warning. 

You also see a small icon on the road showing the position of the speed 

enforcement zone camera at the start of the zone. 

 
 

Intermediate warning - type 1 

Once in the speed check zone, if you are not speeding and have already 

received a start of zone warning, you see a visual warning in the Driving 

View. This reminds you that you are still in the speed check zone. 

 
 

Intermediate warning - type 2 

Once in the speed check zone, if you are driving faster than the permitted 

speed and have already received a start of zone warning, you see a visu-

al warning in the Driving View indicating the maximum permitted speed. 

You also hear a quiet audible warning. These warnings are there to re-

mind you to slow down... 



80 

 

 

 

 
 

Intermediate warning - type 3 

Once in the speed check zone, if you are driving faster than the permitted 

speed and have not received a start of zone warning, you see a visual 

warning in the Driving View indicating the maximum permitted speed. 

You also hear a loud audible warning. 

These warnings occur at the FIRST intermediate point only and are there 

to remind you to slow down... 

 
 

End of zone warning 

As you approach the end of a Speed Enforcement Zone, you see a visual 

warning in the Driving View with a distance to the camera shown under-

neath it. You hear an audible warning. 

You also see a small icon on the road showing the position of the speed 

enforcement zone camera at the end of the zone. 

 
 

Speed Cameras menu 

To open the Speed Cameras menu, tap options in the Main Menu and then tap Speed Cameras. 

 

Report speed cam-

era 
 

Quick Menu option! 

Tap this button to report a new speed camera location. 

 

Change warning 

preferences 
 

Tap this button to set the warnings you will receive and the sounds used 

for each warning. 

 

Disable speed 

cameras 
 

Tap this button to disable warnings. 

 

Enable report but-

ton 
 

Tap this button to enable the report button. The report button is shown in 

the Driving View or in the Quick Menu. 

When the report button is shown in the Driving View, this button chang-

es to Disable report button. 
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Danger zones in France 

About danger zones 

Since January 3, 2012, it has been illegal to receive warnings about the position of fixed or mobile 

speed cameras when you are driving in France. To be compliant with this change in French law, all 

types of speed camera locations and safety-related features are no longer reported; instead, areas 

of danger are indicated as zones.  

In France, TomTom terminated the Speed Cameras service and introduced a new service called 

TomTom Danger Zones. 

Danger zones may or may not contain one or more speed cameras or a range of other driving 

hazards: 

 Specific locations are not available and a danger zone icon is shown instead as you approach 

the zone. 

 The length of the zone depends on the road type at the current location and can be 300m, 

2000m or 4000m. 

 The location of one or more speed cameras, if any, can be at any point within the zone. 

 If two danger zones are close to each other, the warnings can be merged into a single longer 

zone. 

Important: Outside of France, you receive warnings about speed cameras. Inside France, you 

receive warnings about danger zones. When you cross the border, the type of warning you re-

ceive changes. 
 

Danger zone warnings 

Warnings are given 15 seconds before you reach a danger zone. You are warned in three ways: 

 Your device plays a warning sound. 

 Your distance from the danger zone is shown in the Driving View. If a speed restriction is 

known for the zone, the speed is also shown in the Driving View. While you are driving in a 

danger zone, the warning remains on the Driving View. 

 The location of the danger zone is shown on the map. 
 

Changing the way you are warned 

To change the way your TomTom Rider warns you about danger zones, tap Alert settings. 

 

You can then set the warning sound played. 

1. Tap options in the Main Menu. 

Danger Zones 
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2. Tap Danger zones. 

3. Tap Change warning preferences. 

4. Select when you want to be warned about danger zones. You can select to always be warned, 

never be warned or only be warned if you are speeding. 

5. Tap the sound you want to be used for the warning. 

The warning sound is played and you are asked to confirm that you want this warning sound. 

Tap No to select another sound. 

6. Tap Done to save your changes. 
 

Report button 

Note: It is not possible to remove a danger zone. 

To show the report button in the Driving View, do the following: 

1. Tap options in the Main Menu. 

2. Tap Danger zones. 

3. Tap Enable report button. 

4. Tap Done. 

The report button is shown on left-hand side of the Driving View or, if you are already using 

the quick menu, it's added to the buttons available in the Quick Menu. 

Tip: To hide the report button, tap Disable report button in the Danger zones menu. 
 

Reporting a new danger zone while on the move 

To report a danger zone while on the move, do the following: 

1. Tap the report button shown in the Driving View or in the quick menu to record the location of 

the danger zone. 

2. Confirm that you want to add a danger zone. 

You see a message confirming that a report has been created. 
 

Reporting a new danger zone while at home 

You do not need to be at the location of a danger zone to report the new location. To report a new 

danger zone location while you are at home, do the following: 

1. Tap options in the Main Menu on your navigation device. 

2. Tap Danger zones. 

3. Tap Report danger zone. 

4. Use the cursor to mark the location of the danger zone on the map, then tap Done. 

5. Tap Yes to confirm the location of the danger zone. 

You see a message confirming that a report has been created. 
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Safety Alerts menu 

Important: Outside of France, you receive warnings about speed cameras. Inside France, you 

receive warnings about danger zones. When you cross the border, the type of warning you re-

ceive changes. 

To open the Danger zones menu, tap options in the Main Menu and then tap Danger zones. 

 

Report danger 

zone 
 

Tap this button to report a new danger zone location. 

 

Change warning 

preferences 
 

Tap this button to set when you receive warnings and the sound. 

 

Disable danger 

zones 
 

Tap this button to disable warnings. 

 

Enable report but-

ton 
 

Tap this button to enable the report button. The report button is shown in 

the Driving View or in the Quick Menu. 

When the report button is shown in the Driving View, this button chang-

es to Disable report button. 
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About getting help 

Help me provides an easy way to navigate to emergency services centers and other specialized 

services and contact them by phone. 

For example, if you are involved in a car accident, you could use Help me to call the nearest hos-

pital and tell them your exact location. 

Quick Menu option! 

Note: Information may not be available for all services in all countries. 
 

Using Help to call a local service 

You can use Help me to plan a route to local services, make contact by phone and inform the 

service about the precise details of your current location. 

When you search for a service center, you are shown a list of the nearest services. Select one of 

the services in the list to view their address and phone number and to see your current location on 

the map. 

To use Help me to locate an emergency service, contact them by phone and plan a route to the 

emergency service location, do the following: 

1. Tap the screen to bring up the Main Menu. 

2. Tap options. 

3. Tap Help me. 

4. Tap Call for help. 

5. Select the type of service you require. For this example, tap Nearest hospital. 

6. Select a service from the list. The nearest service is shown at the top of the list. For this exam-

ple, tap the one at the top of the list. 

Your current location is shown on the map together with the phone number of the service. 

This helps you to explain where you are when you call the service for help. 

7. To plan a route from your current location to the service location, tap Navigate there. 

Your navigation device starts guiding you to your destination. 
 

Help menu options 

Note: In some countries, information may not be available for all services. 

Call for help 
 

Tap this button to find the contact details and location of a service cen-

ter. 

Drive to help 
 

Tap this button to plan a route to a service by road. 

Help 
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About TomTom HOME 

Using TomTom HOME you can register and manage your TomTom Rider to receive free updates 

and buy new services. It's a good idea to connect to HOME frequently so you can do the follow-

ing: 

 Download the most recent map available for your device for free. 

 Download updates for your device for free, including Map Share updates and other services 

included with your product. 

 Add new items to your device, like maps, voices and POIs, as well as buy TomTom services 

and manage your subscriptions. 

 Share your map corrections and other content with the TomTom community. 

 Make and restore backups of your device. 

When using HOME, you can get help with what you are doing from the HOME Help. You can also 

read about all the other things that HOME can do for you.  

Tip: We recommend using a broadband internet connection whenever you connect to HOME. 
 

Installing TomTom HOME 

The steps below refer to Internet Explorer on Windows XP. If you're using another browser or 

operating system, visit tomtom.com/support for more information. 

To install TomTom HOME on your computer, do the following: 

1. Connect your computer to the internet. 

2. Click the link below to download the latest version of TomTom HOME: 

tomtom.com/getstarted 

3. We recommend downloading the file to your computer by clicking Save. 

4. Once the download is complete, click Open. 

If you accidentally closed the Download Complete window, locate the file 

TomTomHOME2winlatest.exe on your computer and double-click it. 

5. If you get a security warning, click Run. 

6. Click Next, then click Install. 

The installation starts. 

7. Once the installation is complete click Finish. 
 

MyTomTom account 

To download content and services using TomTom HOME, you need a MyTomTom account. You 

can create an account when you start using TomTom HOME. 

TomTom HOME 

http://www.tomtom.com/
http://www.tomtom.com/getstarted
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Note: If you have more than one TomTom device, you need a separate MyTomTom account for 

each device. 

If you have a MyTomTom account, you can access the following benefits online using HOME or 

by using the MyTomTom section of tomtom.com: 

 Services - click Services on the TomTom website to subscribe to services such as real-time 

traffic and safety camera information. 

 Newsletters - click MyTomTom followed by Account details on the TomTom website to man-

age newsletter subscriptions and language preferences for product news 

 Support - click My Questions on the TomTom website to track and view your case history and 

all email conversations you have with TomTom about technical support issues via the website. 

You can also update cases with new information. 

 Orders - click My Orders on the TomTom website to view items you ordered from the 

TomTom website and your order history. 

 TomTom Map Share - report and download map corrections by joining the Map Share com-

munity using HOME. You can then benefit from shared reporting of map issues such as miss-

ing streets and wrong driving instructions.  

 Downloads - download free items using TomTom HOME. 

 
 

Updating your device 

Before you start, make sure you have a backup of your device or memory card. For more infor-

mation, see Backing up your navigation device. 

You can check for updates for your maps, services and for a whole range of other free items or 

items for purchase. The instructions below describe how to update the TomTom application on 

your device. 

1. To check for an updated application version do the following: 

2. Connect your TomTom device to your computer and switch it on. 

3. Wait for TomTom HOME to start. 

4. If HOME does not automatically check for updates, click Update my device in the HOME 

menu. 

Note: If you would like to install an application you downloaded previously, click Add Traffic, 

Voices, Speedy Cameras, etc. > Items on my computer. 

5. If a new application is available, it is listed on the next screen. 

6. Make sure the new application is selected, then click Download updates. 

HOME downloads the selected items... 

7. HOME then installs the selected items on your device. 

8. Click Done. 

9. Click Device > Disconnect Device in the HOME menu. You can then disconnect your device or 

card from your computer.  
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Backing up your navigation device 

The easiest way to make a backup of all the contents of your TomTom navigation device is by 

using TomTom HOME. You can make one backup per device and store it on your computer. 

When you make a new backup, the old backup for that device is overwritten. 

1. Insert your memory card into the card reader connected to your computer. 

TomTom HOME starts automatically. 

Tip: If TomTom HOME does not start, do one of the following: 

Windows: Click on the Start menu and go to All Programs > TomTom and then click on 

TomTom HOME. 

Mac: Click Go in the Finder menu and choose Applications, then double-click TomTom 

HOME. 

2. Click Back up and restore in the HOME menu. 

3.  Click Back up my device. 

4. Click Back up now. 

HOME backs up your device. 

5. Wait until HOME has finished creating the backup, then click Done. 

 

To see where HOME saves your backups do one of the following: 

Windows: Click Tools > TomTom HOME Preferences and then select the Folder Preferences tab. 

Mac: Click TomTom HOME > Preferences... and then select the Folder Preferences tab. 

 

To restore a backup, click Back up and restore in the HOME menu and then click Restore my de-

vice.  
 

Introducing HOME help 

In the TomTom HOME Help topics you can find a lot more information about how HOME can help 

you to manage contents and services on your navigation device. 

You can also get help on the following: 

 Initializing a memory card 

 Using a card reader 

 Updating your device-account combination 

 The TomTom Route Planner 

 Downloading free or shared sounds, images and symbols 

 Installing themes and extensions 

For information on how to create your own POIs, themes, voices, routes, color schemes, symbols 

and sounds, see create.tomtom.com. 

 

http://create.tomtom.com/
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Important Safety Notices and Warnings 

Global Positioning System 

The Global Positioning System (GPS) is a satellite-based system that provides location and timing 

information around the globe. GPS is operated and controlled under the sole responsibility of the 

Government of the United States of America, which is responsible for its availability and accuracy. 

Any changes in GPS availability and accuracy, or in environmental conditions, may impact the 

operation of this device. TomTom does not accept any liability for the availability and accuracy of 

GPS. 

Use with care 

Use of TomTom products while driving still means that you need to drive with due care and atten-

tion. 

Aircraft and hospitals 

Use of devices with an antenna is prohibited on most aircraft, in many hospitals and in many other 

locations. This device must not be used in these environments. 
 

Battery 

This product uses a Lithium-Ion battery.  

Do not use it in a humid, wet and/or corrosive environment. Do not put, store or leave your prod-

uct in or near a heat source, in a high temperature location, in strong direct sunlight, in a micro-

wave oven or in a pressurized container, and do not expose it to temperatures over 60°C (140°F). 

Failure to follow these guidelines may cause the battery to leak acid, become hot, explode or ig-

nite and cause injury and/or damage. Do not pierce, open or disassemble the battery. If the battery 

leaks and you come into contact with the leaked fluids, rinse thoroughly with water and seek 

medical attention immediately. For safety reasons, and to prolong the service life of the battery, 

charging will not occur at low (below 0°C/32°F) or high (over 45°C/113°F) temperatures. 

Temperatures: Standard operation: 0°C (32°F) to 45°C (113°F); short period storage: -20°C (-4°F) to 

60°C (140°F); long period storage: -20°C (-4°F) to 25°C (77°F). 

Caution: risk of explosion if battery is replaced with an incorrect type. 

Do not remove or attempt to remove the non-user-replaceable battery. If you have a problem with 

the battery, please contact TomTom customer support. 

Addendum 
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THE BATTERY CONTAINED IN THE PRODUCT MUST BE RECYCLED OR DISPOSED OF PROPERLY 

ACCORDING TO THE LOCAL LAWS AND REGULATIONS AND ALWAYS KEPT SEPARATE FROM 

HOUSEHOLD WASTE. BY DOING THIS YOU WILL HELP CONSERVE THE ENVIRONMENT. USE 

YOUR TOMTOM DEVICE ONLY WITH THE SUPPLIED DC POWER CORD (CAR 

CHARGER/BATTERY CABLE), AC ADAPTER (HOME CHARGER), IN AN APPROVED CRADLE OR 

USING THE SUPPLIED USB CABLE TO CONNECT TO A COMPUTER FOR BATTERY CHARGING. 

 

If your device requires a charger, please use this device with the charger provided. For replace-

ment chargers, go to tomtom.com for information about approved chargers for your device. 

The stated battery life is a maximum possible battery life. The maximum battery life will only be 

achieved under specific atmospheric conditions. The estimated maximum battery life is based on 

an average usage profile. 

For tips on extending the battery life, see this FAQ: tomtom.com/batterytips. 
 

Do not disassemble or crush, bend or deform, puncture or shred. 

Do not modify or remanufacture, attempt to insert foreign objects into the battery, immerse or 

expose to water or other liquids, expose to fire, explosion or other hazard. 

Only use the battery for a system for which it is specified. 

Only use the battery with a charging system that has been qualified for use with the system per 

this standard. Use of an unqualified battery or charger may present a risk of fire, explosion, leak-

age or other hazard. 

Do not short circuit a battery or allow metallic conductive objects to contact battery terminals. 

Replace the battery only with another battery that has been qualified with the system per this 

standard, IEEE-Std-1725-200x. Use of an unqualified battery may present a risk of fire, explosion, 

leakage or other hazard. 

Promptly dispose of used batteries in accordance with local regulations. 

Battery usage by children should be supervised. 

Avoid dropping the device. If the device is dropped, especially on a hard surface, and the user 

suspects damage, take it to a service center for inspection. 

Improper battery use may result in a fire, explosion or other hazard. 

For those host devices that utilize a USB port as a charging source, the host device's user manual 

shall include a statement that the navigation device shall only be connected to products that bear 

the USB-IF logo or have completed the USB-IF compliance program. 
 

http://www.tomtom.com/
http://www.tomtom.com/batterytips
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CE marking 

This equipment complies with the requirements for CE marking when used in a residential, com-

mercial, vehicular or light industrial environment, meeting all the appropriate provisions of the 

relevant legislation in the EU. 

 
 

R&TTE directive 

Hereby, TomTom declares that TomTom personal navigation devices and accessories are in com-

pliance with the essential requirements and other relevant provisions of the EU Directive 

1999/5/EC. The declaration of conformity can be found here: tomtom.com/legal. 
 

WEEE directive 

This symbol on the product or its packaging indicates that this product shall not be treated as 

household waste. In line with EU Directive 2002/96/EC for waste electrical and electronic equip-

ment (WEEE), this electrical product must not be disposed of as unsorted municipal waste. Please 

dispose of this product by returning it to the point of sale or to your local municipal collection 

point for recycling. 

 
 

C-tick 

 N14644 

This product displays the C-tick to show it complies with relevant Australian regulations. 
 

Customer support contact 

Australia: 1300 135 604 

New Zealand: 0800 450 973 
 

Notice for New Zealand 

This product displays supplier code Z1230 to show it complies with relevant New Zealand regula-

tions. 
 

Warning for Australia 

The user needs to switch off the device when exposed to areas with potentially explosive atmos-

pheres such as gas stations, chemical storage depots and blasting operations. 
 

http://www.tomtom.com/legal
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Customer support contact 

Malaysia 1800815318 

Singapore 8006162269 

Thailand 0018006121008 

Indonesia 0018030612011 
 

FCC information for the user 

 

 

 

THE DEVICE COMPLIES WITH PART 15 OF THE FCC RULES 

Federal Communications Commission (FCC) Statement 

Radio and television interference 

This equipment radiates radio frequency energy and if not used properly - that is, in strict accord-

ance with the instructions in this manual - may cause interference to radio communications and 

television reception. 

This device has been tested and found to comply with the limits for a Class B digital device, pur-

suant to part 15 of the FCC rules. These limits are designed to provide reasonable protection 

against harmful interference in a residential installation. This equipment generates, uses and can 

radiate radio frequency energy and, if not installed and used in accordance with the instructions, 

may cause harmful interference to radio communications. However, there is no guarantee that 

interference will not occur in a particular installation. If this equipment does cause harmful inter-

ference to radio or television reception, which can be determined by turning the equipment off 

and on, the user is encouraged to try to correct the interference by one or more of the following 

measures: 

Reorient or relocate the receiving antenna. 

Increase the separation between the equipment and receiver. 

Connect the equipment into an outlet on a circuit different from that to which the receiver is con-

nected. 

Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications not expressly approved by the party responsible for compliance could 

void the user's authority to operate the equipment. 

Important 

This equipment was tested for FCC compliance under conditions that included the use of shielded 

cables and connectors between it and the peripherals. It is important that you use shielded cables 

and connectors to reduce the possibility of causing radio and television interference. Shielded 

cables, suitable for the product range, can be obtained from an authorized dealer. If the user mod-

ifies the equipment or its peripherals in any way, and these modifications are not approved by 

TomTom, the FCC may withdraw the user’s right to operate the equipment. For customers in the 

USA, the following booklet prepared by the Federal Communications Commission may be of help: 

"How to Identify and Resolve Radio-TV Interference Problems." This booklet is available from the 

US Government Printing Office, Washington, DC 20402. Stock No 004-000-00345-4. 
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FCC Declaration of Conformity 

Tested to comply with FCC standards for home or office use. 

This device complies with part 15 of the FCC rules and with RSS-210 of Industry Canada. Opera-

tion is subject to the following two conditions: 

This device may not cause harmful interference. 

This device must accept any interference received, including interference that may cause unde-

sired operation. 

FCC ID: S4L4GD00 

IC ID: 5767A-4GD00 

FCC RF Radiation Exposure Statement 

The transmitters within this device must not be co-located or operating in conjunction with any 

other antenna or transmitter. 
 

Responsible party in North America 

TomTom, Inc., 150 Baker Avenue Extension, Concord, MA 01742 

Tel: 866 486-6866 option 1 (1-866-4-TomTom) 
 

Emissions information for Canada 

Operation is subject to the following two conditions: 

This device may not cause interference. 

This device must accept any interference, including interference that may cause undesired opera-

tion of the device. 

Operation is subject to the condition that this device does not cause harmful interference. 

This Class B digital apparatus complies with Canadian ICES-003. 

IMPORTANT NOTE 

IC Radiation Exposure Statement: 

This equipment complies with IC RSS-102 radiation exposure limits set forth for an uncontrolled 

environment. 

This device and its antenna(s) must not be co-located or operating in conjunction with any other 

antenna or transmitter. 
 

SPECIAL NOTE REGARDING DRIVING IN CALIFORNIA AND MINNESOTA 

California Vehicle Code Section 26708 "Material Obstructing or Reducing Driver's View" permits 

mounting of a navigation device on the windshield as follows: "A portable Global Positioning Sys-

tem (GPS), which may be mounted in a seven-inch square in the lower corner of the windshield 

farthest removed from the driver or in a five-inch square in the lower corner of the windshield 

nearest to the driver and outside of an airbag deployment zone, if the system is used only for 

door-to-door navigation while the motor vehicle is being operated." Drivers in California should 

not use a suction mount on their side or rear windows. 

Note: This section of the California Vehicle Code applies to anyone driving in California, not just 

California residents. 



94 

 

 

 

Minnesota State Legislature Statutes Section 169.71, subdivision 1, section 2 provides that "A 

person shall not drive or operate with any objects suspended between the driver and the wind-

shield other than sun visors and rearview mirrors and electronic toll collection devices." 

Note: this Minnesota Stature applies to anyone driving in Minnesota, not just Minnesota residents. 

TomTom Inc. bears no responsibility for any fines, penalties or damage that may be incurred by 

disregarding this notice.  While driving in any state with windshield mounting restrictions, 

TomTom recommends the use of the supplied Adhesive Mounting Disk or its Alternative Mount-

ing Kit, which includes multiple options for mounting TomTom devices on the dashboard and the 

air vents. See tomtom.com for more information about these mounting options. 
 

Pacemakers 

Pacemaker manufacturers recommend that a minimum of 15cm (6 inches) be maintained between 

a handheld wireless device and a pacemaker to avoid potential interference with the pacemaker. 

These recommendations are consistent with independent research and recommendations by 

Wireless Technology Research. 

Guidelines for people with pacemakers 

You should ALWAYS keep the device more than 15 cm (6 inches) from your pacemaker. 

You should not carry the device in a breast pocket. 

Other medical devices 

Please consult your physician or the manufacturer of the medical device, to determine if the oper-

ation of your wireless product may interfere with the medical device. 
 

Exposure limits 

This device complies with radiation exposure limits set forth for an uncontrolled environment. In 

order to avoid the possibility of exceeding the radio frequency exposure limits, human proximity 

to the antenna shall not be less than 8 inches (20 cm) during normal operation. 
 

This document 

Great care was taken in preparing this document. Constant product development may mean that 

some information is not entirely up to date. The information in this document is subject to change 

without notice. 

TomTom shall not be liable for technical or editorial errors or omissions contained herein, nor for 

incidental or consequential damages resulting from the performance or use of this document. This 

document contains information protected by copyright. No part of this document may be photo-

copied or reproduced in any form without prior written consent from TomTom N.V. 
 

Model names 

4GD00 

http://www.tomtom.com/
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© 2013 TomTom. All rights reserved. TomTom and the "two hands" logo are registered trade-

marks of TomTom N.V. or one of its subsidiaries. Please see tomtom.com/legal for limited war-

ranty and end user license agreements applying to this product. 

© 2013 TomTom. All rights reserved. This material is proprietary and the subject of copyright 

protection and/or database rights protection and/or other intellectual property rights owned by 

TomTom or its suppliers. The use of this material is subject to the terms of a license agreement. 

Any unauthorized copying or disclosure of this material will lead to criminal and civil liabilities. 

Ordnance Survey © Crown Copyright License number 100026920. 

Data Source © 2013 TomTom 

All rights reserved. 

Data Source 

© 2013 GeoSmart Maps Limited. 

Data Source 

Whereis® map data is © 2013 Telstra® Corporation Limited and its licensors. Whereis® is a reg-

istered trademark of Telstra® Corporation Limited, used under license. 

SoundClear™ acoustic echo cancellation software © Acoustic Technologies Inc. 

Some images are taken from NASA’s Earth Observatory. 

The purpose of NASA's Earth Observatory is to provide a freely-accessible publication on the In-

ternet where the public can obtain new satellite imagery and scientific information about our home 

planet. 

The focus is on Earth’s climate and environmental change: earthobservatory.nasa.gov 

The software included in this product contains copyrighted software that is licensed under the 

GPL. A copy of that license can be viewed in the License section. You can obtain the complete 

corresponding source code from us for a period of three years after our last shipment of this 

product. For more information, visit tomtom.com/gpl or contact your local TomTom customer 

support team via tomtom.com/support. Upon request, we will send you a CD with the corre-

sponding source code. 

Linotype, Frutiger and Univers are trademarks of Linotype GmbH registered in the U.S. Patent and 

Trademark Office and may be registered in certain other jurisdictions. 

MHei is a trademark of The Monotype Corporation and may be registered in certain jurisdictions. 

2013 Tyre® software © ‘t Schrijverke 
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